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With regard to the supply of products, the current issue of the following document is ap-
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Safety
Validity
The chapter “Safety” is valid as instruction manual.

Specific processes and instructions in this document require special precautions to guarantee
the safety of the operating personnel.

Symbols used

This document contains information that you must read for your own personal safety and to
avoid property damage. Depending on the hazard category, the warning signs are displayed in
descending order as follows:

Safety-relevant symbols

Informative symbols

Note!
This symbol brings important information to your attention.

Action
This symbol indicates a paragraph with instructions.
Target Group / Personnel

Responsibility for planning, assembly, commissioning, operation, maintenance, and
dismounting lies with the system operator.

Mounting, installation, commissioning, operation, maintenance and disassembly of any
devices may only be carried out by trained, qualified personnel. The instruction manual must
be read and understood.

Reference to further documentation

Laws, standards, or directives applicable to the intended use must be observed.

The corresponding data sheets, declarations of conformity, EC-type-examination certificates,
certificates and Control Drawings if applicable (see data sheet) are an integral part of this
document. You can find this information under www.pepperl-fuchs.com.

Due to constant revisions, documentation is subject to permanent change. Please refer only to
the most up-to-date version, which can be found under www.pepperl-fuchs.com.
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Marking

WirelessHART® Adapter
WHA-ADP-F8B2-0-P0-GP, WHA-ADP-F8B2-0-PP-GP-1, WHA-ADP-F8B2-N-PP-GP-1,
WHA-ADP-F8B2-P-PP-GP-1, WHA-ADP-F8B2-S-PP-GP-1, WHA-ADP-F8B2-T-PP-GP-1

Pepperl+Fuchs GmbH
LilienthalstraBe 200, 68307 Mannheim, Germany

Intended Use

The devices are only approved for appropriate and intended use. Ignoring these instructions
will void any warranty and absolve the manufacturer from any liability.

The device must only be operated in the ambient temperature range and at the relative
humidity (non-condensing) specified.

The device is an intelligent WirelessHART device designed for the transmission of measured
values from connected C&l or HART devices.

The approved usage of the connected device(s) and gateway can be taken from the
corresponding parts of their instruction manual.

Improper Use

Protection of the operating personnel and the overall system is not ensured if the product is not
being used according to its intended purpose.

Mounting/Installation

Prior to mounting, installation, and commissioning of the device you should make yourself
familiar with the device and carefully read the instruction manual.

The device must not be installed at locations where corrosive vapors may be present.
Do not install damaged or polluted devices.
Only use accessories specified by the manufacturer.

The usage of 2400 MHz equipment is bound to local restrictions. Ensure that local restrictions
allow usage of this product before commissioning.

Country Guideline

Bulgaria General authorization required for outdoor use
and public service.

ltaly If used outside of own premises, general
authorization is required.

Japan The device is granted pursuant to the
Japanese Radio Law and the Japanese
Telecommunications Business Law.

The device must not be modified (otherwise
the granted designation number will become
invalid).

Latvia The outdoor usage of the 2.4 GHz band
requires an authorization from the Electronic
Communications Office.

Norway May be restricted in the geographical area
within a radius of 20 km from the center of Ny-
Alesund.

Rumania Use on a secondary basis. Individual license
required.
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1.10

Operation, Maintenance, Repair
The devices must not be repaired, changed or manipulated.
If there is a defect, the product must always be replaced with an original device.

When the device is in operation, a distance of at least 20 cm must be maintained at all times
between the device antenna and the body of the user or any other person within the vicinity of
the measuring point irrespective of application or use.

Only use accessories specified by the manufacturer.

The device uses a battery unit containing non-rechargeable, high-power batteries. Please refer

to the separate battery safety instructions before storing, handling, transporting and disposing
of the batteries.

Leaking battery acid may cause personal injury and damage to the device.
Never use batteries that are leaking.

Never use batteries with external damages such as dents or deep scratches, even if no
battery acid is leaking.

Delivery, Transport, Disposal

Check the packaging and contents for damage.

Check if you have received every item and if the items received are the ones you ordered.
Keep the original packaging. Always store and transport the device in the original packaging.

Always store the device in a clean and dry environment. The permitted storage temperature
(see data sheet) must be considered.

Disposing of devices, packaging material, and possibly contained batteries must be in
compliance with the applicable laws and guidelines of the respective country.

I3 PEPPERL+FUCHS
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Product Specifications
Introduction

The HART® (Highway Addressable Remote Transducer) communication protocol is used by
many 4 ... 20 mA transmitters to enable digital communication for diagnosis and maintenance
purposes. Many device parameters, but also measurement values, can be transmitted digitally
to and from the device. Until now, HART® technology has mostly been using the wired

4 ... 20 mA loop as physical layer.

WirelessHART® technology now allows for the wireless transmission of HART® data. To be
employable worldwide, WirelessHART® technology utilizes the 2.4 GHz Band (IEEE 802.15.4
wireless network) as physical layer. All WirelessHART devices form a mesh network in which
every device is not just a measurement point, but also a repeater. This results in a bigger range
of the whole network as well as an increased reliability through redundant communication
paths.

Ponlnty
<@

Figure 2.1 WirelessHART mesh network

WirelessHART Temperature Converter
WirelessHART Adapter

WirelessHART Gateway
Fieldbus/Ethernet

Host applications

A A WON =

The WirelessHART network is built up, organized and maintained by the WirelessHART
Gateway and is therefore self-organizing and self-healing. The WirelessHART Gateway also
takes care for connection to different host systems through different industrial protocol bus
interfaces.

The WirelessHART Gateway supplies WirelessHART Temperature Converters and
WirelessHART Adapters with the necessary information for seamless network operation.



[ ]

2.2

2.3

10

Functional Overview

The WirelessHART adapter is an intelligent interface module that connects HART and

4 ... 20 mA devices to a WirelessHART network. It transmits the measurement and diagnosis
information acquired from the connected device(s) to a host application via the WirelessHART
Gateway.

Key Functions

May be connected directly to a HART device or mounted separately. Up to 4 HART
devices may be connected.

LEDs for supply status, communication status and device status indication.

Provides loop-power to the connected device. Alternatively, the connected device may be
powered externally.

Battery life estimation and "Low Battery" alarm
Scope of Delivery
The scope of delivery of the WirelessHART adapter includes:
WirelessHART Adapter with installed battery unit W-BAT-B2-Li, if ordered
Short instructions and CD-ROM
Depending on the order, the delivery may also include the following:
Wall/pipe mounting kit
38 cm cable for connecting the adapter to a field device

A connection adapter for connecting to the cable entry of a field device:
M20/M20 or M20/G 1/2 with two Viton gaskets, M20/NPT 1/2 or M20/NPT 3/4 with one
Viton gasket.

Cable gland

I3 PEPPERL+FUCHS
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Product Specifications

2.4 Design

Controls and Indicators
The button and the LED indicators are inside the housing.

Further information on the indications of the LEDs and the functions of the button: see chapter

6.1.
®
< e
o
026 EHI E
Rl & o
O,
=
Figure 2.2 Controls and indicators
1 Red LED
2 Green LED
3 Yellow LED
4 Button

221980 2013-11
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Product Specifications

Connections and Interfaces
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Figure 2.3 Connections and interfaces

Housing cover with battery compartment
Connector for battery power

Antenna

Counternut

Primary M20x1.5 cable gland
Secondary M20x1.5 cable gland

N OO g WON =

Terminal block

221980 2013-11
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Installation

Mounting Considerations
Positioning the Device

We recommend that you install the WirelessHART Gateway before installing other
WirelessHART devices. This way, you can check for proper operation of new devices as they
are installed. Please refer to the manual of the WirelessHART Gateway for further information.

Guidelines for Planning a WirelessHART Network

A line-of-sight between communication partners always is desirable. If a line-of-sight is
not possible, the obstacles should not be massive and the partners should be more to the
edge of an obstacle to allow the wave to "bend" around it (diffraction effect).

Consider moving objects that could affect the device's antenna range.
Install wireless devices at least 1 m above the ground or the floor.
Make sure that the device's antenna is aligned vertically for best results.

Make sure that a minimum of 2 other WirelessHART devices are well within the antenna
range of the device.

Do not position WirelessHART devices directly below or above each other. They would be
outside each other's antenna range.

Install WirelessHART devices at least 1 m away from each other.

Antennas must be at least 6 cm away from any wall or any metallic material running
parallel to it.

Position the device as far away as possible from metal surfaces or walls containing metal.
There should be as little metal close to the device as possible.

Do not position other 2.4 GHz devices like cordless phone bases or WLAN routers near
WirelessHART devices. Keep in mind other wireless networks using the same frequency
spectrum (WLAN, Bluetooth, etc.). Wireless technologies used in an industrial
environment must be able to coexist without disrupting each other. If multiple networks
operate in one facility, a frequency management should be applied as part of
administration.

13



. WHA-ADP-F8B2-*-P*-GP(-1)

Installation

3.1.2 Antenna Characteristics

Before mounting the device, you should consider the antenna characteristics and the
propagation of the radio waves. The following diagrams show the antenna gain in two different
planes.

/)
200°" 7/

s'/ 7\*1 ~ m/

Figure 3.1 Antenna gain (side view, 2450 MHz, dBi)

X

3100/ ’ 77
3oo/° | \

,\

e
.

%" 190" 1800 170°
Figure 3.2 Antenna gain (top view, 2450 MHz, dBi)

221980 2013-11
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Installation

3.1.3 Examples for Good and Poor Positioning

Figure 3.3 Wave propagation, schematic representation (alpha = approx. 45°, may vary
considerably)

1 Weaker signal above and below
2 Stronger signal sideways

Figure 3.4 Good positioning: Devices are within each others antenna range

221980 2013-11
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Figure 3.5 Poor positioning: Devices are not within each others antenna range

Mounting the Device

The WirelessHART adapter can be mounted in one of three ways:
direct connection to the field device,
separate from the field device, but connected by a cable,
when used as a repeater, as an autark unit.

Direct connection

The direct connection to a field device is made by means of an adapter piece which is screwed
into the cable entry at the side of the adapter. See chapter 3.2.1

Separate mounting

The adapter can be mounted on a wall (see chapter 3.2.2), post (see chapter 3.2.3) or other
object, using the adapter wall/pipe mounting kit, which is available as an accessory. The
connection to the field device is made with standard installation cable and two cable glands. It
is recommended that the blind plug be left in place until the electrical connection is made.

It is recommended that the WirelessHART adapter be installed separate from a field device
when:

there is insufficient space at the measuring point to mount the adapter on the field device,
the signal reception at the measuring point is too weak for correct operation,
the measuring point is subject to vibration above the permissible limits. See chapter 9

Supplied parts

Depending on the order, the following parts may be supplied:
adapter piece for connection to a field device with a M20 cable entry,
adapter piece for connection to a field device with a G 1/2 cable entry,
adapter piece for connection to a field device with a NPT 1/2 cable entry,
adapter piece for connection to a field device with a NPT 3/4 cable entry,
M20 cable gland for separate mounting,
wall/pipe mounting kit.

I3 PEPPERL+FUCHS
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3.2.1 Installation on a Field Device
Required tools:
Metric spanner AF 24 (SW 24) for the connection adapter
Metric spanner AF 25 (SW 25) for the counternut

Figure 3.6 Installation on a field device
1 Counternut

2 Cable entry

3 Connection adapter

Tip

Loosening the counternut allows the adapter to be screwed into position without the need to
turn the adapter housing.

(10

) Mounting the adapter directly on a field device

1. Remove the blind plug from the cable entry at the side of the adapter.
2. Push a Viton gasket on either side of the connection adapter supplied with the adapter.

3. Using a spanner, screw the connection adapter tightly into the cable entry of the field drive
(torque 5 Nm + 1 Nm).

4. Loosen the counternut on the adapter.

5. Insert the other end of the connection adapter into the cable entry of the adapter and screw
tight (torque 5 Nm + 1 Nm).

6. Align the adapter so that the antenna is vertical.
7. With the cable entry nut held with a spanner, tighten the counternut (torque 7 Nm).

I3 PEPPERL+FUCHS 17
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Mounting to a Wall

Figure 3.7 Mounting to a wall with mounting bracket

1 Mounting bracket
2 Blind plug

As an addition to the tools already listed (see chapter 3.2.1), an M4 Allen key/bit is required to
tighten the mounting bracket screws.

Mounting to a wall with mounting bracket

1. Mount the mounting bracket at a suitable position on the wall.
2. Unscrew and remove the counternut.

3. Thread the cable entry through the hole in the mounting bracket such that the antenna is is
on the side farthest away from the wall.

4. Remount the counternut and screw until the adapter is loosely held.
5. Align the adapter so that the antenna is vertical.
6. With the cable entry nut held with a spanner, tighten the counternut (torque 7 Nm).

I3 PEPPERL+FUCHS
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3.2.3 Mounting to a Pipe
O Note!
H The maximum pipe diameter for pipe mounting is 70 mm.

—

_—

< >

q
(®
®

N
Figure 3.8 Mounting to a pipe
1 Pipe/post, & max. 70 mm
2 Pipe mounting bracket
3 Mounting bracket

) Mounting to a Pipe

1.

Mount the pipe mounting bracket at a suitable position on the pipe and screw tight (torque
min. 5 Nm).

Using the four screws supplied, screw the mounting bracket to the pipe mounting bracket
(torque 4 Nm + 1 Nm).

Unscrew and remove the counternut.

Thread the cable entry through the hole in the mounting bracket such that the antenna is is
on the side farthest away from the wall.

Remount the counternut and screw until the adapter is loosely held.
Align the adapter so that the antenna is vertical.

7. With the cable entry nut held with a spanner, tighten the counternut (torque 7 Nm).

I3 PEPPERL+FUCHS

19




[ ]

3.3

3.3.1

20

Electrical Connection to other Devices

The WirelessHART adapter can be connected to the following device types/configurations.

Field device operating in a control loop without communication resistor

Field device operating in a control loop with communication resistor
This configuration is used for HART multidrop with 2, 3, or 4 devices

Two-wire field device operating independently with power supplied by the adapter

Four-wire field device operating independently with power supplied by an external source

The devices are connected to the terminal block located inside the adapter housing.

o = &
\ 4
DANDNOD \H
(6]
ol I
O
I=I
Figure 3.9 Terminal block (1 ... 6) and terminals for HART modem (7 + 8)
Terminal Function
1 Device supply
2 HART /4 ...20 mA
3 External Supply / GND
4,57 HART high impedance
6,8 High impedance GND

Wiring Diagrams

Control loop without communication resistor

In this configuration, the field device is powered externally by a PLC, Remote 1/O, or DC power
supply and outputs a 4 ... 20 mA signal.
The adapter provides the following functions:

Current measurement via 4 ... 20 mA interface

HART digital communication, if supported by the connected device

For communication with the adapter, a HART modem can be connected to terminals 5/7 and

6/8.

I3 PEPPERL+FUCHS
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Installation

Note!

The connection is made across the 270 Q communication resistor of the adapter.

The circuits in the following 2 figures are electrically identical as terminal 4 and 5 are connected
internally.

— see Figure 3.10 on page 21

— see Figure 3.11 on page 21

(10

For loops with two signal lines, the adapter should be wired as shown in the following figure.

®+

O<

DL

[ 2 & EHE) [

Figure 3.10 Connection of adapter to a control loop without communication resistor

1 PLC, Remote 1/0,DC power supply without communication resistor
2 Field device (passive)

For loops with only one signal line (common ground), the adapter should be wired as shown in
the following figure.

© el
A

DD DD
(1] [2] [3] [4H5] [6]

Figure 3.11 Alternative method of connection of adapter to a control loop without communication
resistor

1 PLC, Remote I/O, DC power supply without communication resistor

2 Field device (passive)

221980 2013-11
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WHA-ADP-F8B2-*-P*-GP(-1)
Installation

Control loop with communication resistor

In this configuration, the field device is powered externally by a PLC, Remote I/O or DC power
supply and outputs a 4 ... 20 mA signal. Alternatively it is used in HART multidrop mode. The
adapter provides the following functions:

m  HART digital communication

For communication with the adapter, a HART modem can be connected to terminals 5/7 and
6/8.

Note!

The circuits in the following 2 figures are electrically identical as terminal 4 is connected
internally to terminal 5 and terminal 3 is connected internally to terminal 6.

— see Figure 3.12 on page 22

— see Figure 3.13 on page 23

Existing installations: For existing installations, we recommend that the adapter is wired as
shown in the following figure.

Y
Q)
Y
Y
S
N

=]
N
]
]
o
£

+ - -
+
Figure 3.12 Connection of adapter to a control loop with communication resistor
1 PLC, Remote I/O, DC power supply with communication resistor

2 Field device

I3 PEPPERL+FUCHS
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Installation

New installations: For new installations, we recommend that the adapter is wired as shown in
the following figure.

DD ADD
(3] [4H5] [6]
[
+ - -
+
Figure 3.13 Alternative method of connection of adapter to a control loop with communication
resistor
1 PLC, Remote I/0O, DC power supply with communication resistor

2 Field device

Two-wire device powered by adapter

In this configuration, the field device is operating independently and is powered by the adapter.
The adapter provides the following functions:

m Current measurement via 4 ... 20 mA interface,

= HART digital communication, if supported by the connected device.

Note!

For HART devices, we recommend that the device is operated in multidrop mode to prolong
battery life. In this case, a polling address between 1 and 14 is set and the device outputs a
constant current of 4 mA.

[0

N
S
S
S
S
S

=
N
(]
&
]
£

()| ©

Figure 3.14 Connection of loop-powered device to active adapter

1 Field device (passive)

221980 2013-11
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Four-wire device

In this configuration, the field device is operating independently and is powered by an external
power source. The adapter provides the following functions:

m Current measurement via 4 ... 20 mA interface,

= HART digital communication, if supported by the connected device.

)
)
N
S
S
S

(=]
N
]
]
]
=]

-
®

©
@+

Figure 3.15 Connection of active four-wire device to passive adapter

1 Four-wire field device (active)
2 External Power Source

3.3.2 Connecting Cables
Required tools:
m  Phillips screwdrive PZ1 to open the adapter cover,
m  Screwdriver with 2.5 mm blade to make the connections.

If the adapter is mounted on the field device, use the two wires supplied to make the
connection.

If the adapter is to be mounted separately, standard installation cable can be used. If strong
electromagnetic interference is to be expected (machines, walkie-talkies), use shielded,
twisted pairs. Connect the shield to the ground terminal.

e e

® o
Figure 3.16 Opening the cover i
R
o
1 Captive screws 3
[\
8V}

2 I3 PEPPERL+FUCHS
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Figure 3.17 Cable entries

1 Primary cable entry (blind plug seals adapter when cable entry not in use)
2 Secondary cable entry with M20x1.5 cable gland

Note!
The secondary cable entry in the base of the adapter should be used in following situations:
if the adapter is mounted separately on a wall or pipe

for the power cables when the field device is operating in a control loop

Direct wiring (adapter mounted on field device)

When the adapter is mounted directly on the field device, the wiring is done through the
connection adapter as follows.

1. Open the housing of the adapter by unscrewing the four captive screws. Also open the con-
nection compartment of the field device.

2. Thread the two wires supplied through the connection adapter (primary cable entry).

3. Connect the WirelessHART adapter according to the appropriate wiring diagram. See
chapter 3.3.1

4. If an external power line is to be connected, use the secondary cable entry.
5. Connect the field device according to the instructions in its operating manual.

6. If the devices are not to be commissioned immediately after connection, close the housing
and field device connection compartment.

7. In order to obtain optimal sealing of the adapter housing, tightened the screws to a torque of
0.5 Nm.

Wiring (adapter mounted separately)

1. Open the housing of the adapter by unscrewing the four captive screws. Also open the con-
nection compartment of the field device.

2. Using a M20x1.5 cable gland, thread the connecting or power cable through the secondary
cable entry into the adapter.

3. Connect the WirelessHART adapter according to the appropriate wiring diagram. See
chapter 3.3.1

4. Pull the cable taut. The adapter cover is a tight fit an a trapped cable may prevent proper
closure.

5. Tighten the cable gland.
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9.

Connect the field device according to the instructions in its operating manual.

If the devices are not to be commissioned immediately after connection, close the housing
and field device connection compartment.

In order to obtain optimal sealing of the adapter housing, tightened the screws to a torque of
0.5 Nm.

Tighten the cable gland and, if required, the blind plug to a torque of 3.5 Nm.

Electrical Specification

Loop power for field device (Terminal 1):

Offload voltage 8 VDC to 23 VDC, adjustable in steps of 0.1 VDC

Current 4mA<Iy<20mADC

corresponding to the NAMUR recommendation NE 43

4 ... 20 mA/HART input (Terminal 2)

Current 4mA<[;,<20mADC

corresponding to the NAMUR recommendation NE 43

High impedance HART interface (Terminals 4, 5, 6)

Input impendance 3.7 kQ for HART communication, Version 1.00.xx
5.0 kQ for HART communication, Version 1.01.xx upwards
DC input impedance infinite
Maximum terminal voltage
Across Terminals 2 + 3: U;<30VvDC
Across Terminals 5 + 6: U;<30VvDC
O Note!
H Due to the internal communication resistor, the supply voltage of the field device depends upon

the offload voltage and the current signal.

26
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Commissioning
Connected HART Device(s)

It is recommended that the connected HART device is commissioned before the adapter.

Note!
It is not necessary to assign different HART addresses for different adapters. The

addresses used on the network also incorporate the serial number of the adapters and

are automatically unique for each adapter.

4 ... 20 mA devices require no pre-configuration. The scaling and any linearization are

configured within the adapter DTM.

Parameterizing the field device

1. Connect a configuration tool, for example, PACTware ™ to the field device using a HART

modem.

If the adapter shall power the field device, first power the adapter by connecting the battery
and then continue with this step. During the start-up phase of the adapter, the field device
goes on and off again. If the field device does not power up again after the communication
started, power the field device for 5 minutes (time can be configured in adapter DTM) by

pushing the adapter button for more than 10 seconds until the red LED flashes.
2. Set the following parameters for the field device:

HART address: sets the output mode of the device (0 =4 ... 20 mA; 1 ... 15 = HART)

* If the device is connected to an existing 4...20 mA loop, use the address = 0

e Otherwise use address = 1 for HART multidrop mode with a 4 mA current output.

* If more than one HART device is connected (up to 4 are allowed if externally
powered), each must have a unique address between 1 and 14, e.g. 1, 2, 3, 4.

Device Tag: identifies the measuring point.

Long Tag: identifies the device on the wireless network.
Long Tags are available from HART Version 6.0 onwards. For earlier versions, for
example, HART 5 instruments, use the Message instead.

Connecting the Battery

Warning!

Caustic battery acid

Leaking battery acid can cause personal injury and damage to the device.
Never use batteries that are leaking.

Never use batteries with external damage such dents or deep scratches, even if no
battery acid is leaking.

Caution!
Possible damage because of wrong battery

Using the wrong type of battery may cause damage to the device.

Use lithium primary batteries from Pepperl+Fuchs approved for this device only.

I3 PEPPERL+FUCHS
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Commissioning

) Connecting the battery

The adapter is delivered with the battery unit installed but not connected. It is connected as
follows.

1. If necessary, open the adapter cover by unscrewing the four captive Phillips screws. — see
Figure 3.16 on page 24

2. Plug the battery cable into the battery connector.

¢ o| e ©
kg

O

| 0.0 [
[ajn}

® o

S .Y =

Figure 4.1 Inserting and connecting the battery
1 Battery

2 Battery cable plugged into battery connector

Lo As soon as the battery is connected, the adapter initializes.

- The occupation of the terminals is checked.

- The type of device connected is checked.

- If a HART device is connected, its data are read into the adapter.
- The LEDs indicate the status of the device. see chapter 6.1.1

- The adapter is now ready for commissioning.

I3 PEPPERL+FUCHS
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4.4
4.4.1
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Initial Configuration via HART Modem

For security reasons, the Network ID and Join Key must be configured through a wired
connection before the device can connect itself to a WirelessHART network. To do so, you can
use a HART modem that connects to a PC/Laptop using the USB interface or the RS232
interface.

Connecting the device to a PC/Laptop via HART modem

Install the HART modem drivers on your PC/Laptop according to the instructions given by the
manufacturer.

1.

If necessary, open the housing cover by unscrewing the four captive Phillips screws. — see
Figure 3.16 on page 24

Connect the HART modem to terminals 7 + 8. You can also use terminals 5 + 6 as these
terminals are connected internally. — see Figure 3.9 on page 20

If the HART modem has an internal communication resistor, this should be switched off at
the first attempt to communicate. If communication fails, a resistor may be required. See
chapter 8

Switch on your PC/Laptop.

Plug the HART modem into the USB/RS232 port.

Lo If using the USB port, your PC/Laptop should recognize the HART modem automatically.
If using the RS232 port, proceed with the next step.

To find out to which COM port the HART modem is connected, open the Windows® device
manager. For example, if using Windows® XP, click Start > Settings > Control Panel >
System > Hardware > Device Manager, or if using Windows® 7, click Windows Icon >
Control Panel > System > Device Manager.

L5 Under Ports (COM & LPT) you see the HART modem and the COM port assigned to it.
You will need the COM port number later on.

DTM Software
Downloading the Required Software

Required software:

Microsoft® .NET Framework

PACTware™ Framework

WirelessHART DTM
The DTM collection including WirelessHART device DTMs and Ethernet communication
DTM.

HART CommDTM

The HART CommDTM has to be installed separately. It is required for wired
communication via HART modem. The HART CommDTM supports both FSK (i.e. HART
modem) and RS-485 interfaces.

Note!

If one of the software components is already installed on your system, the installation may be
omitted.
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Where to download the required software?

A 0D~

5.

Open your internet browser and visit www.pepperl-fuchs.com.

Click Products.

Click Software.

Download the software components Microsoft® .NET Framework, PACTwareTM,

WirelessHART DTM and HART CommDTM. You might need to scroll down the page to
find the required component.

Unzip the downloaded files and store the data to your local hard drive.

Install the DTM Software Components

Your computer must meet the following requirements in order to run PACTware ™ and the
device DTM:

Operating system: Windows® 2000 Service Pack 4, Windows® XP Service Pack 1/2/3 or
Windows® Vista

Software: Microsoft® .NET Framework Release 1.1 Service Pack 1

Processor: 500 MHz or faster

Memory: 256 MB RAM or more

Disk space: 200 MB or more

Graphics resolution: 1024 x 768 or higher

Administrator privileges to enable software installation

Install the DTM Software Components

1.

Install the Microsoft® .NET Framework by starting the corresponding setup.exe file and fol-
lowing the installation instructions given on the screen.

. Install PACTware ™ by starting the corresponding setup.exe file and following the installation

instructions given on the screen.

Install the WirelessHART DTM collection by starting the corresponding setup.exe file and
following the installation instructions given on the screen.

Install the HART CommDTM by starting the corresponding setup.exe file and following the
installation instructions given on the screen.

L5 You have installed the required software.

I3 PEPPERL+FUCHS

221980 2013-11



221980 2013-11

4.4.3

4.5
4.5.1
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Updating the DTM Catalog

Once you have installed the FDT base application and the Device Type Manager (DTM) on the
computer, the FDT base application's DTM catalog must be updated. The PACTware™ DTM

catalog is called "Device Catalog" and is normally automatically updated when PACTware™ is
launched.

If PACTware™ does not update the device catalog automatically, proceed as follows.
Updating the Device Catalog

1. Start PACTware™.,

2. Select View > Device Catalog or press F3 or click on the Device Catalog icon in the icon
bar.

L The Device Catalog window opens.
3. Click on the Update Device Catalog button to update the device catalog.

|ievice cataleg

Al DevicesPESPERL + LIS Gbrt
Lo = Potocel -
£73 oH-a FIIS Co shion o

FU L0k brdeer Erang (2-hanak) { P+

FE 1203 Frocueraflrgus (x) PP FB
(8 P 1o bendver Engand (B-kansbgh [ P4 PO Intamal
[, FB 1301 biieer Ergang (2-kanalg) ( P4F F8 Intemal
[ P8 1302 b Ersparg (3-hanaiy) { F4F P tmral B
B 1303 Frequera/Tmpuls (Ex

FB 2202 Ventiveber (24 V[ 210 Obs P4F F8 Intemal
FR 2203 Verdltendes (74 V [ 360 Ofx P4F Fl Intmrl
FEB 2204 Ventitvaber (22 V [ 220 O P4F PO Intsmal
FB 2206 Ventltvober (228 [ 290 C PAF P8 Intamal
Mender | Growo | Type | Profocol FB 2206 Verdilraber (16.5Y¥ [ 115 C P4FFl Intermal  PEPPERL#FUCHS GmbiH

— 5 72717 vanhitvmba (16 5 ¥ L1701 1 A S intwal_ EFPEFES 4F1Ms bt
T Shuwe ol dervices p 3

PEFPERLAFUICHS GmbH M Campanert(s)

Update devies sty [ |

Figure 4.2 PACTware ™ device catalog

4. Click on Yes to continue.

Lo The updated device catalog appears once the search has finished.

.

Search for FDT 1.2 DTMs...

DOCHPUFLIb. clsFD T 1 2Buzineszz0bject
PACTware action active. One moment please.

Figure 4.3 PACTware ™ search for DTM

Creating a new Project in PACTware ™

Creating a New Project
Creating a new project in PACTware™?

Select File > New or click on the Create New Project icon on the toolbar.

Lo A new, unnamed project appears in the main window. The project initially consists of the
entry HOST PC.
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Adding the Communication DTM

A communication DTM is an interface between the FDT frame application and the device DTM.

The communication DTM enables communication between the device DTM and the device
connected to the PC.

For the PC to communicate with the device via the HART modem, a HART communication
DTM has to be added to the PACTware ™ project.

Adding HART communication DTM

Note!

The HART CommDTM is not included in the WirelessHART DTM Collection. It can be
downloaded separately from www.pepperl-fuchs.com. see chapter 4.4

1. Select the entry HOST PC in the project view of your PACTware ™ project.
2. Choose Device > Add device or click the Add device icon on the toolbar.

=1

———

L5 The Device for window appears.

Device for

All Devices

Lok =[] |k | Group g
T_—] COM-R5232-300 P+F KE R5232 (P PEPPERL+FUCHS GmbH GUUT-Devices 1.
£ E-Mux Communication HART LDP Codewrights GmbH FDT 0.
“_“,’f’ HART Communication THART CodeWrights GmbH FDT 10
E PZP R5232Z FOT l’\§ FzP FEPPERL+FIICHS GmbH FDT L
ng PROFIdtm DPYL Profibus DP{Y1  Softing AG FDT Wi
‘g Servicebus interface LB/FE series P+F LE FE Service PEPPERL+FUCHS GmbH FDT 1.1
ET TCI Cornmunication Profibus_DPY1  PACTware Consortium eV, TC1

< I i)
» HART Communication FOT 1.2 DTM

Figure 4.4 Selection of HART communication DTM

3. Select the entry HART communication.
4. Click OK.
L5 The HART communication DTM is added to the project.

Project I x

Device kag
HOST PC
HAT oL

Figure 4.5 HART communication DTM in PACTware™ project
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5. To edit the parameters, double-click on the HART communication DTM.

L9 The parameter window appears.

|ﬂﬁ COM1 Parameter | 4 b x
HART
SAF Communication interface HAF!T mocllem v
Sernial Interface Port CDM1 V
HART protocal M aster | Primary M aster _v'
Preamble 10 e |
Murnber of commurication |5 [
retries - -
Address scan Start address ]
End address -15
[ Multimaster and Burst mode support (works only with standard F5-232)
[ Ok ] ’ Cancel I [ Apply ]
Figure 4.6 Parameter window of HART communication DTM

6. Setthe parameters according to the following table.
7. Click OK to save the changes and to close the parameter window.

Parameter Description Default
Communication | Set this parameter to HART modem. HART
interface modem
Port Set this parameter to the COM port your HART modem is COM1
connected to.
Master Set this parameter to Secondary master. Primary
Master
Preamble Number of preambles for HART communication. 5
Number of The number of retries for HART communication in case of an | 3
communication error.
retries
Start address Here the address range is set, in which the HART 0
Communication DTM is to search for HART devices
End address connected to the HART modem. 15
Set this parameter to Start address = 14, End address = 15.
15 is the default value of the adapter.
Multimaster and | Activate this check box. deactivat
Burst mode ed
support
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45.3 Adding Device DTM
) Performing a HART scan

In the Communications DTM, the function Additional functions > Scan list can be used to
scan the connected HART devices.

1. Inthe project view, right-click on the entry of the communication DTM you have added in the
previous step.

2. Choose Connect.
3. Choose Additional functions > Scan list.
4. If the scan does not begin on its own, click on the Refresh button.

L The scan begins (Start address and End address as specified is the previous section).
All detected field devices are displayes in the Scan list window.

) Adding the Device DTM

You may add the adapter to your PACTware™ project in various ways (see PACTware™
documentation). One of them is described in the following.

1. Inthe project view, right-click on the entry of the HART communication DTM.
2. To add the device DTM, choose Add device.

L5 The Device for window opens.

Device for
Al Devices
Device | Pratacal ‘endor
Generic HART DTM HART 1C5 GmbH
‘i}! KFDZ-HMM-16 (FDT) HART - HMMS PEPPERL-+FUCHS GmbH
M Mux 2700F (FOT) HART - HMMS PEPPERL+FUCHS GmbH
m Mux 2700G (FOT) HART - HMMS PEPPERL+FUCHS GrabH
WHA-ADP HART - HART PEPPERL-+FUCHS GmbH
WHA-GW HART; HART UDP - HART  Pepperl+Fuchs GmbH
WHA-UT HART PEPPERL+FUCHS GrabH

= WHA-ADPE# A, DD-Yers, 932251 -1

K ] [ Cancel

3. Select WHA-ADP.
4. Click OK.

L5 The device DTM is added to the project. You may continue with parameterizing the
adapter as described in the following.

Praoject 1 x

Device tag
HOST PC
= 4 CoM1
o [FA wHa-ADP

5. Remember to save your PACTware ™ project from time to time (File > Save).
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Joining the Wireless Network

To connect itself to the WirelessHART network, the device must carry the correct Network ID
and Join Key. The Network ID and Join Key have to be configured using a wired connection
before the device joins the WirelessHART network for the first time.

To enter Network ID and Join Key, the following requirements have to be met.

A PC/Laptop is connected to the device using a HART modem.

A PACTware™ project containing the HART communication DTM and the device DTM
has been created.

In the joining phase the device sends a join request packet to the network manager. If the new
device can be authenticated, the network manager responds with an activation packet and sets
up links between the new device and other existing nodes. Furthermore, the new device
receives a 128 Bit encryption key.

Entering Network ID and Join Key

1. Inthe PACTware™ project, right-click the DTM of the device that shall join the Wire-
lessHART network.

Project 1 x

Drevice bag

HOST PC
T ComL

o A wha-ur

Figure 4.7 Device DTM in the PACTware ™ project

2. Choose Connect.
L A connection is established.

3. To open the online parameterization window, right-click the device DTM and choose
Parameter > Online parameterization.

L The online parameterization window appears.
4. In the online parameterization window, choose Wireless Communication.
L The wireless communication parameters are displayed. See chapter 5

5. Enter the Network ID into the Network Identification field and press Enter to confirm the
new value.

6. Enter the Join Key into the 4 Join Key fields and press Enter to confirm the new value.
7. Click Execute Join.

Lo The device attempts to join the wireless network. The connection status is indicated by
Join Status.
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Configuration
Configuration Options

We recommend that you configure the device on the shop floor via a wired connection using
a HART modem. see chapter 5.2

1. Define all basic settings such as wireless communication parameters (Network ID, Join
Key, Join Mode) and identification parameters (Long Tag, Polling Address) usinga HART
modem.

2. Make the device join the WirelessHART network.

3. Once the device has joined the WirelessHART network, configure the burst mode param-
eters, event notifications, and other application settings using a HART modem.

4. Disconnect the HART modem and install the device in the field.

Once the device is installed in the field, you can change the configuration of the device via a
wireless connection using the WirelessHART Gateway.

Wireless Configuration via the WirelessHART Gateway

We assume that the WirelessHART Gateway is installed and configured correctly according to
the manual of the WirelessHART Gateway. Furthermore, we assume that the device to be
configured has joined the WirelessHART network.

1. Start your PACTware™ project containing the device DTM of the WirelessHART Gateway.

Project 1 x
Device tag address | (] 3=
HOST PC
= 7 HART TP Communication & Al
A wHa-gw 1 v
Figure 5.1 DTM of the WirelessHART Gateway in the PACTware™ project view

2. In the project view, right-click on the entry WHA-GW.
3. To add the device DTM, choose Add device from the context menu.

L5 The Device for window opens.

Device for

All Devices

Device 4 Protocol Vendaor Group De
Generic HART DTM HART 105 GmbH DTM spexific 40
.ﬁ! KFD2-HMM-16 (FDT) HART - HMMS PEPPERL+FIICHS @mbH FOT 1t
M Mux 2700F (FOT) HART - HMMS PEPPERL+FIICHS @mbH FOT

m Muzx 2700G (FDT) HART - HMMS PEPPERL+FIICHS @mbH FOT

WHA-GYW HART; HART UDP Pepperl+Fuchs GmbH DTM specific
h WHA-UT {HART PEPPERL-+FUCHS GmbH Temperature

- e

&

o \WHA-LT Bty DO-Yers, 93-226-1-1

Figure 5.2 Device for window with device DTM

4. Select the entry of the WirelessHART device you want to add to the PACTware ™ project.
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[0

[0

[0

5. Click OK.

L9 The device DTM is added to the project.
Now you can continue with parameterizing the device as if you had a wired connection. see
chapter 5.2

Project o x

Device tag

B HOSTPC

EIE" E-Mux Comm

2 A whaaw

e WHA-LT
Figure 5.3 DTM in the PACTware™ project view
Note!

Note that you can accelerate the wireless configuration by establishing a fast pipe connection
between the device and the WirelessHART Gateway. For more information on fast pipe
connections, see the manual of the WirelessHART Gateway.

Online and Offline Parameterization (DTM)

Note!
The concept of online/offline parameterization applies to the configuration via DTM and
PACTware™ only.

The device DTM provides dialogs for offline and online parameterization.
Offline Parameterization (not connected to device)

If there is no active connection to the device, only the data that is stored locally in the

PACTware™ project can be edited and saved. You can store this local copy of the data to
the device, as soon as a connection to the device has been established.

To ensure that you edit the latest data: Before editing the data offline, load the latest
version of the data from the device when the device is online.

Online Parameterization (connected to device)

If there is an active connection to the device: You can directly edit the data that is stored
on the device. Parameter changes are immediately stored on the device.

Both online and offline data are updated using the commands Store to device and Load from
device.

Note!
Data edited and stored on the device during online parameterization is not automatically
synchronized with the offline data record in the PACTware™ project. If you change device

parameters in the online mode, the data stored in the PACTware ™ project differs from the data
stored on the device.

To ensure that the data stored in the PACTware™ project matches the data stored on the

device, after online parameterization, load the data from the device into the PACTware ™
project.
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) To parameterize offline

1.

Right-click the device entry in the PACTware ™ project.

L5 A context menu opens.

. Choose Parameter > Parameterization.

L5 A window with the offline data record appears.

In order to modify a parameter, enter a new value or choose a new value from the drop-
down list.

4. To accept the new value, press Enter.

. After all parameter changes have been made, save your project by choosing File > Save.

To write the new offline configuration to the device, right-click the device entry in the project
view and choose Connect.

Lo A connection to the device is established.
Right-click the device entry again and choose Store to device.

Lo The new configuration is stored on the device.

) To parameterize online

1.

38

Right-click the device entry in the PACTware™ project.

L A context menu opens.

. Select Connect.

L A connection to the device is established.

Right-click the device entry in the PACTware™ project.

. Select Parameter > Online Parameterization.

L5 A window with the online data opens and the data is read from the device.

In order to modify a parameter, enter a new value or choose a new value from the drop-
down list.

. To accept the new value, press Enter.

L The new value is immediately stored onto the device.

After all online parameter changes have been made, you can load the online configuration

into the PACTware™ project. To do this, right-click on the device entry in the project view
and choose Load from device.

Lo The device date is loaded in the PACTware™ project.
In order to safe your project, choose File > Save.
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5.3

Identification Parameters

The identification parameters provide various information about the device and identify the
device within the network.

= 4-20 m&

% Cannected

|E WHA-ADP1 # Online parameterization |

Device Name:

NE107 Status: [ Good

‘Wireless Communication

Wired Communication

Device Wariable Mapping
(= Application Settings

Linearization
(= Burst Mode
Burst Mode 1
Burst Mode 2
Burst Mode 3
Burst Mode 4
Burst Mode 5
Burst Mode 6
Burst Mode 7
Burst Mode §
Burst Mode 9
Burst Mode 10
(=) Event Mokification
Ervent Matification 1
Event Maotification 2
Ewent Matification 3
Ewent Matification 4
Event Matification 5
Fower Supply

WHA-ADP Device Reyision: 1

Long Tag: WHA-ADPL Descriptor: WIRELESSADAPTOR

Timestamp of Status: 14:03:32

Long Tag: WHA-ADP1

Device Tag: WHA-ADP
Descripkor: WIRELESSADAPTOR
Date Code: 01.04.2009
Message: NOME
Folling Address: 15
Counkry Code:

Germany v

SI Units Only: | Mo pestrictions | %

& & Device @

Figure 5.4

Identification parameters

Identification Parameters

Parameter | Description Default
Long Tag | Identifies the device in a WirelessHART network. Enter up to 32 -
characters.
Device Tag| Identifies the field device within the process plant. Enter up to 8 -
characters.
Descriptor| Further description of the device. Enter up to 16 characters. -
Date Code | Date of last parameter change. Format: DD.MM.YYYY 01.04.2009
Message | User defined message. Enter up to 32 characters. -
Polling HART address of the adapter on the wired interface, valid range 15
Address |0 ... 63. Since the long tag and MAC address are used to identify
the device in the WirelessHART network, it is not necessary to give
different devices different polling addresses.
Country | Select the country code of the country in which the device is -
Code operated from this drop-down list.
Governs the signal strength that can be set for the device
Determines the preset value for "SI Units only"
Sl Units Selects the unit set to be used by the adapter.
only Unit codes restricted to Sl units only: only Sl units are displayed
No restrictions: Both metric and US units are displayed
39
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Configuration

5.4 Wireless Communication Parameters
The wireless communication parameters apply to the WirelessHART network that the device
will join.
WHA-ADP1 # Dnline parameterization ] q X
Device Name: WHA-ADP Device Revision: 1
Long Tag: WHa-ADF1 Descriptor: WIRELESSADAPTOR.
NE107 Status: . Good Timestamp of Status: 14:04:32
Lall=lt
Ol Lerizati 2
Secning Da.n.ame. Erieatian MNetwork Identification: | 1945 o
s de Flc on
- \Wired Communicat wireless Operation Mode: ©3 Cperotonal
- Device Yariable Mapping
= Application Settings Radia Pawer: 10 dBm
=1 4-20 mé,
- Lineatization Join Key Part 1 of 4 {decimal): |* |
= Burst Mode '
- Burst Made 1 Join Key Part 2 of 4 {decimal): |"‘ |
- Burst Mode 2
- Burst Mode 3 ) ) -
- BireEMai Join Key Part 3 of 4 {decimal): | |
- Burst Mode 5
- Burst Made 6 Juin Key Part 4 of 4 (decimal): |* |
- Burst Mode 7 ) i
- Burst Mode & Join Shed Time [hhimm;ss]: |DD:4D:UD |
- Burst Mode 9
- Burst Mode 10 Join Mode: |Attempt to join immediately on power-up or reset
=) Event: Motification
- Event Motification 1 Execute Join: [ oo ]
- Event Motification 2
- Event Matification 3 X
. Event Motification 4 Join Status: 3 g Metwark, P_ac;ets Heard .
- Event Natification S fehheq e )
- Power Supply [ Synchronized ta Slok Time
[ Advertisement Heard
[l Join Requested
O Jnin Retrying
[ Jain Failed
[ Autherticated
[l Matwork Joined
[ Megatiating Metwork Properties
[o#] Karmal Operation Commencing
Total Mumber of Meighbours: £3 | 7 |
Murnber of Advertising Packets Received: | i} |
Mumnber of Join Attempts: | 1 |
Active Advertising Shed Time [hhimm;ss]: |DD:DD:UD |
Request Active Advertising: [ ES ]
Mumber of Meighbours Advertising: | i} |
* connected & B osvice [ !
Figure 5.5 Wireless communication parameters
O Note!
H The data listed in the following table is available only during online parameterization.
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Wireless Communication Parameters

Do not attempt to join
Join now

Attempt to join immediately on powerup or reset

Parameter Description Default
Network Unique Network ID of the WirelessHART network the device | —
Identification | is supposed to join. Enter up to 5 digits (0 ... 99999).
Wireless Indicates current mode of operation of the device: -
f\)llp?jratlon Idle: waiting for trigger to start join procedure
ode
Active Search: searching for neighboring WirelessHART
devices
Negotiating: connection parameters are being
exchanged with the network manager (gateway)
Quarantined: network manager has temporarily stopped
the device from joining the network
Operational: device is connected to the network
Suspended: network manager has permanently stopped
the device from joining the network
Deep Sleep/Ultra-low Power/Passive Search: adapter is
inactive
Radio Power | Power of the radio signal emitted by the device. The selection| 0 dBm
and the default value depend on the Country Code
parameter.
Join Key Part | The join key is the password for the network the device isto | —
x of 4 join. Enter 32 hexdecimal characters. There are four text
fields that can hold eight characters each.
Join Shed Time (hh:mm:ss) that the device is given to join the network | 00:40:00
Time after the Join Mode condition has been fulfilled. After this
time has elapsed, the device will keep on trying to join the
network using a low duty-cycle receive mode to reduce
energy consumption (yellow COM LED off).
Join Mode Joining behavior of the device: Attempt to join

immediately ...

Execute Join

Press the button to store the Join Shed Time and Join
Mode parameters to the device. The device will attempt to
join the network in the way that is specified in Join Mode.

Join Status

Indicates the current status when joining the network.
Possible messages:

Network Packets Heard

ASN Acquired

Synchronized to time slot
Advertisement Heard

Join Requested

Join Retrying

Join Failed

Authenticated

Network Joined

Negotiating Network Properties
Normal Operation Commencing
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Parameter Description Default
Total number | Number of WirelessHART devices to which a connection has| —

of Neighbors | been established.

Number of Number of advertising packages received by the device. -
Advertising

Packets

received

Number of Number of attempts the device has made to join the network.| —

Join Attempts

Active Time in hh:mm:ss that the device is given to advertise its 00:40:00
Advertising | presence to its neighbors in order that they can join the

Shed Time network quickly.

Request Pressing this button will cause the device to advertise its -
Active presence for the period Active Advertising Shed Time.
Advertising

Number of Number of neighbors that are advertising their presence and| —
Neighbors have been detected by the device.

Advertising

Wired Communication Parameters

The Wired Communication parameters pertain to the HART communication between the

adapter and and HART device(s) connected to it. Up to four HART devices can be connected

in multidrop mode to the adapter, each requiring a different HART address.

= Onl.ine paramneterization
Identification

(= Application Settings

(= 4-20 md
Linearization

(=~ Burst Mode
Burst Mode 1
Burst Mode 2
Burst Mode 3
Burst Mode 4
Burst Mode 5
Burst Mode 6
Burst Mode 7
Burst Mode &
Burst Mode 9

Power Supply

JE WHA-ADP1 # Online parameterization |
Device Name:
Long Tag:

NE107 Status: [l Good

Device Variable Mapping

Burst Mode 10

(=~ Event Maotification
Event Motification 1
Event Maotification 2
Event Motification 3
Event Motification 4
Event Maotification 5

‘WHA-ADP Device Revision: 1
\WHA-ADPL Descriptor: \WIRELESSADAPTOR.
Timestamp of Status: 14:04:32
Polling Address: 63

Master Type: :Primary Master [

Preambles: 20

Retries: 3

Lowest Scan Address: a
Highest Scan Address: 15

= i Device. B

Scan Subdevices:
Field Device Table
Manufacturer ID | Expanded Device T | Device ID Universal Comman | Long Tag Start-Up Voltage
AEBE TTX300 series 2057000 5 ABE_TTH300_MN 16

Figure 5.6

Wired communication parameters
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Wired Communication Parameters

Parameter

Description

Default

Polling
Address

HART address of the device set in ldentification.

Master Type

HART master role to be assumed by the adapter.
Primary master: The connected HART device has no other
permanent master.

Secondary master: The connected HART device communicates
with a permanent HART primary master, e.g. PLC.

If a handheld device or PACTware ™ are connected temporarily to
the HART device when the adapter is operational, they must have
the role of secondary master.

Primary
Master

Preambles

Number of preambles sent at start of HART frame to sychronize
communication with the connected HART device. All connected
devices must have the same settings. Valid range: 5 ... 20.

Retries

Number of times the adapter tries to establish communication with
a connected HART device before it reports a communication error

Lowest Scan
Address

Address from which the adapter starts scanning for connected
HART devices.

Highest Scan
Address

Address at which the adapter stops scanning for connected HART
devices.

A HART device providing a 4 ... 20 mA output in a control loop
will have the address 0.

Normally a single HART device powered by the adapter will
have the address 1, as this ensures it is operating in multidrop
mode (current 4 mA)

For a multidrop bus (max. 4 devices) enter the highest address.

Scan
Subdevices

Press the button to scan the connected HART devices. The devices
found, together with their parameters, are displayed in the Field
Device Table.

If the HART device is disconnected or its configuration changed, a
new scan must be made

Note: A scan is made every time the adapter is powered up after
connection of the battery — the table then fills automatically.

Field Device
Table

Displays the parameters read from the HART device by the scan.
Manufacturer ID: Manufacturer of connected device.

Expanded Device Type Code: Device identifier as per HART.
Device ID: Manufacturer’s device identifier.
Universal Command Revision Level: HART revision supported.

Long Tag: Long tag of device (Message for HART revision <
6.0).

Start-Up Voltage: Voltage required to start the connected device,
Start-Up Time: Time required for the device to wake-up
Start-Up Current: Current consumed on starting the device
Lead Time: Time that elapses between start-up and the point at

which the device can deliver valid values. See chapter 5.8
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Configuration

5.6 Device Variable Mapping

The adapter can output the value and status of several variables, but a maximum of only four
variables can be published on the network. The device variable mapping is used to configure
these variables.

J WHA-ADP1 # Online parameterization ] 4 bx
Device Name: WHA-ADP Device Revision: 1
Long Tag: WHA-ADPL Descriptor: WIRELESSADAPTOR
ME107 Status: . Good Timestamp of Status: 14:05:27
= Online parameterization e e i =
. Identification elect Primary Variable: |Loop Current
~Wireless Communication
-~ ired C icati Primary Yariable Lnit: mé
= Application Settings Select Secondary Yariable: |Temperature El
= 4-20 mA
- Linearization Secondary Yariable Urit: | ¢
=) Burst Mode
- Burst Mode 1 -- 1
Select Tertiary Variable: Battery Volkage «
- Burst Made 2 | L J D
- Burst Mode 3 . ; ;
oA Tertiary Yariable Unit: |\-'
- Burst Mode 5
- Burst Mode 6 Select Quaternary Yariable: |Estimated Lifetime ‘zl
- Burst Mode 7 )
- Burst Mode & Quaternary Yariable Unit: |d
- Bursk Mode 9
- Burst Mode 10
(= Event Natification
- Event Motification 1
- Event Motification 2
- Event Matification 3
- Event Motification 4
- Event Motification 5
- Prower Supphy
== connected =l E,_Device [ e
Figure 5.7 Device variable mapping

The variables that can be set as SV, TV and QV are as follows:
Temperature

Temperature min

Temperature max

Battery voltage

Consumer energy

RSL of best neighbour (RSL = Radio Signal Level)
RSL of second best neighbour

Battery voltage with load

Battery voltage without load during battery test
Normalized Consumer Energy

Estimated Lifetime

221980 2013-11
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Device variable mapping

I3 PEPPERL+FUCHS

Parameter Description Default
Select Primary Variable to be output as primary variable (PV) Loop
Variable Current
(fixed)
Primary Variable | Engineering units of the primary variable mA
Unit (fixed)
Select Secondary | Variable to be output as secondary variable (SV) Temperat
Variable ure
Secondary Engineering units of the secondary variable (fixed) °C
Variable Unit
Select Tertiary Variable to be output as tertiary variable (SV) Battery
Variable Voltage
Tertiary Variable | Engineering units of the tertiary variable (fixed) \Y
Unit
Select Quaternary| Variable to be output as quaternary variable (SV) Normaliz
Variable ed
Consum
er
Energy
Quaternary Engineering units of the quaternary variable (fixed) Ah
Variable Unit
45



5.7 Application Settings
5.7.1 4..20mA

When a HART device is connected to the adapter, all parameters are read via the digital signal.
It is possible, however, to connect a 4 ... 20 mA device to the adapter. In this case the

4 ... 20 mA signal can be scaled as desired in the DTM and a linearization can be made if
necessary. In addition, current values can be set which correspond to the limits of the
proportional range and the fault signal of the device. Should these current limits be violated, an
appropriate warning or alarm signal is transmitted by the adapter.

|E WHA-ADP1 # Online parameterization | q kX
Device Name: WHA-ADP Device Revision: 1 o
o
Long Tag: WHA-ADPL Descriptor: WIRELESSADAPTOR
NE107 Status: [ Good Timestamp of Status: 14:06:10
i= Onl-ine parameterization Pri wariable Linit: [ T
Identification AR ".m By
‘Wireless Cammunication _ e
\Wired Communication Linearization Mode: | Linear |
Primary Variable Upper Range Yalue (20 ma): 20| ma
Primary Variable Lower Range Yalue (4 ma): 4| md
(= Burst Made
Burst Made 1 Input Darping: ols
Burst Mode 2
Bursk Mode 3
Burek Made 4 Upper Fault-Current Yalue: 21| ma
Bursk Mode 5
Burst Mode 6 Upper Limit of Propattional Range: 20,5 | mA
Burst Mode 7
Burst Mode & Lower Limit of Proportional Range: 3,8 ma
Burst Mode 2
Burst Mode 10 Lower Fault-Current Value: 36| ma
[=- Event Makification
Evenit: Notification L Trim Loop Current Zero: [ i |

Event Motification 2

Event Motification 3

Event Motification 4 Trim Loop Current Gain: [ 33 l

Ewent Motification 5
Power Supply

== Connected = i Device =

Figure 5.8 4-20 mA parameters

Device variable mapping
Parameter Description Default
Primary Variable | The unit of the primary variable supplied by the 4 ... 20 mA mA
Unit device. The selection changes the units of the scaling

parameters.

Linearization Determines how the current input will be converted to the Linear
Mode output.

Linear: Proportional scaling across the set range

Special curve: Scaling according to the table in
Linearization

Primary Variable | Output value assigned to the 20 mA current input 20 mA
Upper Range
Value (20 mA)

0 FPEPPERL+FUCHS
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Parameter Description Default
Primary Variable | Output value assigned to the 4 mA current input 4 mA
Lower Range
Value (4 mA)
Input Damping Damping factor for the current input in seconds (valid range |0
0...255)
Upper Fault- Max. current output by 4 ... 20 mA device when in fault 22 mA
Current Value condition.
The adapter outputs an alarm if the current input reaches this
level.
Upper Limit of Upper limit value of proportional range. The adapter outputs a| 20.5 mA
Proportional warning if the current input exceeds this level.
Range
Lower Limit of Lower limit value of proportional range. The adapter outputs a| 3.8 mA
Proportional warning if the current input drops below this level.
Range
Lower Fault- Min. current output by 4 ... 20 mA device when in fault 3.6 mA

Current Value

condition.
The adapter outputs an alarm if the current input reaches or
drops below this level.

Trim Loop Current
Zero

When pressed, calibrates the 4 mA signal of the connected
device. 4 mA must be simulated or an "empty" calibration
made.

Trim Loop Current
Gain

When pressed, calibrates the 20 mA signal of the connected
device. 20 mA must be simulated or a "full" calibration made.

Linearization parameters

If the linearization mode "Special Curve" is selected, the "Linearization" leaf must be opened:

Up to 32 value pairs can be entered

X values must be entered in increasing order, Y values must rise or fall monotonically (red

= error)

Range end values must correspond to those in the 4-20 mA leaf

A graphic shows the linearization curve

I3 PEPPERL+FUCHS
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WHA-ADP1 # Online parameterization ] 4 X

Device Name: WHA-ADP Device Revision: 1
Long Tag: WHA-ADPL Descriptor: WIRELESSADAPTOR

ME107 Status: . Good Timestamp of Status: 14:05:41

Lell=It,

= Online parameterization
- Identification
- Wireless Communication
- Wired Communication
- Device Wariable Mapping
- Application Sektings
=) 4-20 mA
. Lineatization
= Burst Mode
- Burst Mode 1
- Burst Mode 2
- Burst Mode 3
- Burst Mode 4
- Burst Mode 5
- Burst Made &
- Burst Mode 7
- Burst Mode &
- Burst Mode 9
- Burst Mode 10
(=) Event Motification
- Event Motification 1
- Event Nokification 2
- Event Nokification 3
- Event Nokification 4
- Event Nokification 5
- Powet Supply

xima |¥: i |A:

20

i
i1}

s

10

5
|

T FEL L (7Y ) I ) L o I L L ] I T R
5 0 15 20
mé

Read Wirite

ﬂ\? Connected | Ty &,_Device = ﬁ(

Figure 5.9 Linearization

Linearization

Parameter Description Default
X:mA (1 ...32) Input value X1 ... X32 for linearization (mA) 4,20
Y: unit (1... 32) Output value Y1 ... Y32 for linearization (engineering units) 4,20

Read Press to upload values from the device into the DTM. -
Happens automatically when the Linearization leaf is
opened.

Write Press to download the table from the DTM to the device. -

221980 2013-11
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5.7.2

Burst Mode Parameters

Burst mode is a special communication mode in which a HART slave device sends responses
to a particular HART command on a predetermined, periodic schedule without being polled by
the master. Normally, a HART slave device only responds when being polled by the master.
When burst mode is used, a HART slave device can publish data (for example process values)
independently in regular time intervals. Data can be sent as scheduled, or only if the value has
changed by a significant amount or has not been updated within a default reporting time.

Up to 10 different burst modes can be set for the adapter or connected HART devices.

Device Name:

Long Tag:
!

nEe

JE WHA-ADP1 # Online parameterization |
WHA-ADF
WHA-ADPL

NE107 Status: [l Good

Device Revision:
Descriptor:

Timestamp of Status:

WIRELESSADAPTOR,

14:08:41

1

= Online parameterization
Identification
‘Wireless Communication
Wired Communication
Device Yariable Mapping
(= Application Settings
(=) 4-20 mé
Linearization

(=~ Burst Modh

Burst Mode 2
Burst Mode 3
Burst Mode 4
Burst Mode 5
Burst Mode &
Burst Mode 7
Burst Mode &
Burst Mode 9
Burst Mode 10
=) Event Matification
Event Motification 1
Event Motification 2
Event Motification 3
Event Motification 4
Event Motification 5
Pawer Supply

% Connecked £ i Dievice

Burst Mode Contral Code: | Wireless

Device Index: ‘-WHA-ADP1
Period [hhimm:ss]: 00:00:08
Max. Period [hh:mm:ss]: 00:00:08
Trigger Mode: _Continuous
Device Variable Class {Trigger):

Unit Code (Trigger):

Trigger Level:

Burst Command Number: 13

5

0| Mok Lsed

Device YariableO:

Device Yariablel:

Device Yariable2:

Dievice Yariabled:

Device Yariabled:

Device YariableS:

Device Yariablet:

Device Yariable?:

Cancel Apply

Figure 5.10

Note!
Battery lifetime

[0

Burst Mode Parameters

The more frequently burst messages are sent the more battery power is consumed, thus

reducing battery lifetime.
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Burst Mode 1 ... 10 Parameters

Parameter

Description

Default

Burst Mode
Control Code

Switches burst mode on or off ("Wireless" = on).

The following parameters in this table can only be edited if
Burst Mode Control Code is set to "Wireless". Otherwise
they are grayed out.

The field will also show "Off" if the parameters are
downloaded when the adapter is not in the network. The
parameters are retained and become active when the adapter
joins the network.

Off

Device Index

Selects the device via its long tag for which the burst mode
applies.
<Adapter Long Tag>: Adapter parameters are transmitted.

<Device Long Tag>: Device parameters are transmitted.

For HART devices of Revision 5 or lower, the "Message"
serves as the long tag. See chapter 4.1

Not
selected

Period

When the trigger mode is set to "continuous", determines
the period in hh:mm:ss that elapses between burst
messages.

When the trigger mode is not set to "continuous”,
determines the scan rate in hh:mm:ss for checking
whether the trigger condition for a burst message is
fulfilled.

The minimum setting is 8 seconds.

00:30:00

Max. Period

When the Trigger Mode is not set to "continuous", determines
the maximum period in hh:mm:ss that may elapse between
two burst messages when the conditions for the trigger are not
fulfilled.

01:00:00

Trigger Mode

Determines the event that triggers a burst message from the
device.

Continuous: A burst message is published continuously at
intervals determined by Period.

Window: a burst message is triggered when the source
value deviates more than the specified trigger value.

Rising: a burst message is triggered when the source
value rises above the specified trigger value.

Falling: a burst message is triggered when the source
value falls below the specified trigger value.

On-Change: a burst message is triggered when any value
in the message changes.
If the conditions are not met for Trigger Modes "Window",

"Rising", "Falling" and "On-Change", a burst message is sent
at intervals determined by Max. Period.

Continuo
us

Device Variable
Class (Trigger)

Determines the device variable that is used to trigger the burst
message, e.g. Temperature.

Not
classified

Unit Code
(Trigger)

Engineering unit used by the trigger variable, e.g. °C

Not used

Trigger Level

Value of the source variable which is used to trigger the burst
message, e.g. 150°C

0
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Parameter

Description

Default

Burst Command
Number

Determines which commands are to be sent in the burst
message.

1 Primary variable: Returns the primary value and units.

2 Loop current and percentage of range: Returns the loop
current and its associated percent of range.

3 Dynamic variables and loop current: Returns the loop
current and up to four predefined dynamic variables and
units (PV, SV, TV, QV).

9 Device variables: Returns the value of up to 8 device or
dynamic variables with units.

33 Device variables and additional device status: Returns
the value of up to four device variables and the device
status information.

48 Additional device status: Returns the device status
information.

For connected HART devices, check the operating manual to
see which commands are supported: if you are uncertain, use
Command 3 as default

1

Device Variable
0..7

Selects the device variables to be transmitted in the burst
message when command 9 or 33 is entered as Burst
Command Number:

For the adapter, select the variable you want to transmit
from the drop-down menu.

For a connected HART device, check the operating
manual (loop-current, PV, SV, TV and QV can be
selected).

250

Cancel

Click to make the setting to revert to their original values.

Apply

Click to download the changes to the device.

I3 PEPPERL+FUCHS
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Event Notification

Event notification is a special application of a burst message and publishes changes in the

device configuration and status, independent of data publishing supported in other burst mode

commands. For events, the status included in the Device Status byte, Extended Device Status

byte and Command 48 can be used. It is possible to specify a limited set of bits that will trigger

event notification.

Event notifications have a low priority but carry a time stamp in order to indicate the first time
when a notification occurred. Up to 5 different event notification messages can be defined in

the leaves Event Notification 1 ... 5.

Each Event Notification window (1 ... 5) is subdivided into 3 tabs:

Event
Standard Event Mask
Device-Specific Event Mask

JE WHA-ADP1 # Online parameterization |
Device Name: WHA-ADP Device Revision: 1
Long Tag: WHA-ADP1 Descriptor: WIRELESSADAPTOR
!
ME107 Status: [ Good Timestamp of Status: 14:08:41 =
i i= Onl.ine parameterization 1~
P - Event | Standard Event Mask | Device-Specific Event Mask Tl
W!reless Comm.unlc.atlon Event Notification Control Code: Wireléss v
Wired Communication
Device Yariable Mapping . r
= Application Settings Device Index: ABE_TTH300_M i
= 4-20 mé
Lineatization Event Motification Retry Time: 00:30:00
= Burst Mode
Burst Mode 1 Maximum Update Time: 00:30:00
Burst Mode 2
Burst Mode 3 Event Debounce Intersyal: 00:30:00
Burst Mode 4
Burst Mode 5 Event Status: [ Canfiguration Changed Event Pending
Burst Mode & [ Device Status Event Pending
Burst Made 7 [ Mare Status Available Event Pending
Burst Mode &
Burst Mode First unACK Time: | 00:00:00
Burst Mode 10
=)+ Event Mokification
Event Motification 1
Event Motification 2
Event Motification 3
Event Motification 4
Event Notification 5
Power Supply r
| A
PR ( .'. - ) J
% Connected G’—" i Device ﬁ

Figure 5.11 Event notification, tab Event
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Event Tab

Parameter

Description

Default

Event Notification
Control Code

Switches event notification on or off ("Wireless" = on).
The following parameters in this table can only be edited if
Event Notification Control Code is set to "Wireless".
Otherwise they are grayed out.

Off

Device Index

Selects the device via its long tag for which the burst mode
applies.
<Adapter Long Tag>: Adapter parameters are transmitted.

<Device Long Tag>: Device parameters are transmitted.

For HART devices of Revision 5 or lower, the "Message"
serves as the long tag (see chapter 4.1).

Event Notification
Retry Time

Period between retransmissions of the event notification. The
event notification continues to be retransmitted until
anacknowledgement of the event is received.

00:30:00

Maximum Update
Time

Maximum period in seconds that may elapse between
successive event notifications. If no event occurs, the adapter
will publish an event notification after this time has elapsed.

00:30:00

Event Debounce | The amount of time that a condition must persist before the | 00:30:00
Interval event notification is sent out.
Event Status Indicates whether a particular event notification has been sent| —
and is still unacknowledged.
Configuration Changed Event pending
Device Status Event Pending
More Status Available Event Pending
First unACK Time | Indicates the time in seconds an event naotification has -
remained unacknowledged.
|l whA-ADP1 # Online parameterization 1 b X
Device Name: WHA-ADF Device Revision: 1 |
- Long Tag:  WHA-ADP1 Descriptor:  WIRELESSADAPTOR
MNE1D7 Status: ‘ Gaod Timestamp of Status: 14:08:41
s]f=IC
& Online parameterization Everit | Standard Event Mask | Device-Specific Event Mask [l
Identification [
Wireless Communication Device Status: L1 Primary Yariable Out of Limits Standardized Status 0: [ Process values are simulated,
Wired Communication [ Won-Primary Yariable Out of Limits [ Hardware is defect,
Device Yariabls Mapping [ Loop Current Saturated [ Hardware is defect. |
=+ Application Settings [ Loop Current Fixed [ Software reached an unexpected st
(=) 4-20 mA [ More Status Avalable [ Either field device or internal woltage|
Linearization [ Cold Start [ Temperature of Adapter is not withic
(= Burst Made [ Configuration Changed [ Hardware is defect.
Burst Mode 1 [ Device Malfunction
Burst Mode 2 Standardized Status 2: [ Device was added or kaken away fro|
Burst Mode 3 Extended Device Status: I The battery unit has energy for less than 30 days, [ Adapter discovered another master |
Burst Mode 4 L] One of the device variables is not valid.
Buret Mude 5 [ Battery Failure: fisld device na longsr powered. Standardized Status 3: [ Adapter was unable to get required |
Burst Mode 6 [ adapter asked for bandwidth and aw
Buret Moda 7 Loop Current Saturated: [ Analog Channel 1 [ Firmware update is in process.
B [] Analog Channel 2
urst Mode 3
Buret Moda 9 [ Analog Channel 3
Burst Mode 10 [ Analog Channel 4
=+ Event Notffication
e Loop Current Fixed: [ Analog Channel
Ewvent Motification 1
[] &nalog Channel 2
Event Motification 2
i [] Analog Channel 3
Ewvent Notification 3
[ &nalog Channel 4
Event Motification 4
Ewvent Notification 5
Power Supply
% Connected & g Device ﬂ
Figure 5.12 Event notification, tab Standard Event Mask
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Standard Event Mask Tab

Parameter

Description

Default

The Standard Event Mask tab contains the standardized
HART events. Activate the approriate checkbox to activate
event notification for the associated condition.

Checkbo
Xes
deactivat
ed

E3 wha-aDP1 # Online parameterization 4px
Device Name:  WHA-ADP Device Revision: 1
- Long Tag: \WHA-ADPL Descriptor: W IRELESSADAPTOR
ME107 Status; . Good Timestamp of Status: 14:11:08
o B@
= Onling parameterization Event | Standard Event Mask | Device-Specific Event Mask ~
Identification F = i
Wireless Communication ByteD:  [JEitO Byte3:  [JEEO Bytef:  []EED Byte®:  [JEEO Byte12:  [1Bik0
wWired Communication [Ceit 1 Bt 1 [lBit1 [ git 1 gL
Device Yariabls Mapping (B z Btz etz Btz Bz
- Application Settings CIBit3 CBit3 CIBit3 B3 ClEE3
= 4-20 mA [ Bit 4 [JEit4 [CIEit4 [ Bit 4 B4
Linsarization [1Bit5 ClBts [lBits [lBks [lBits
=) Burst Mode [IBit6 [l Bits [lBite [ Bit6 [1Bite
Eurst Mode 1 (I Bic 7 Bt ? Bt 7 [ Bic 7 Bt
Burst Mode 2
Burst Mode 3 Byte 1: [JBit 0 Byte 4: [Jeito Byte 7: [1Bito Byte 10: [JBit 0 Byte 13: [lBito
Burst Made 4 [l Bit 1 et 1 [Teit1 [l Bik 1 (WE:S%
Burst Mode 5 [Ceicz Btz Btz (et z Btz
Burst Mode & Bt 3 [l Bit3 B3 Bt s [IEit3
Burst Mode 7 (Bt 4 [ Eit4 [TEit4 et 4 B4
Burst Mode & [IBiS (] [1Bits [1Bis ClBits
Burst Made 9 3 [Cleits [ Bit6 [ Bit & [l Bite
Burst Mode 10 (Bt 7 Bt 7 Bt 7 Bt 7 Bt 7
QEEEENctesken Byte 2: Bit 0 Byte 5i Bit 0 Byte 8 Bt 0 Byte 11: Bit 0 Byte 14: B0
Ewent Motification 1
Event Notification 2 [ Bk 1 et 1 (m):13% [ Bit 1 et
Event Notification 3 OBz [ Btz Btz Btz Btz
Event Notification 4 Bt s [ Bit3 [ Eit3 Bt & [JEit3
Event Notification 5 (Bt 4 [ Eit4 [1Eit4 [ et 4 [JEit4
Povir Supply [IBitS [1Bits [l Bits [1BiS [l Bits
[ Bit & [eits [ Bit& [ Bit & [ eits
OBk 7 [IBit? [ Eit? Bt 7 Bt | [
£3 Ji3l
% Connected L= i Device @
Figure 5.13 Event notification, tab Device-Specific Event Mask

Device-Specific Event Mask Tab

Parameter

Description

Default

The Device-Specific Event Mask tab contains device-
specific events. Activate the approriate checkbox to activate
event notification for the associated condition (see

manufacturer’s operating manual).

Checkbo
Xes
deactivat
ed
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5.8 Power Supply

Battery life can be extended by tuning the adapter to energy requirements of the connected
device. In addition, knowledge of the power requirements ensures a more reliable prediction of
battery life. For some HART devices, the power parameters are displayed in the Field Device
Table. For other HART devices and for 4 ... 20 mA devices, they must be taken from the
operating manual and entered manually. The tuning is done in the Power Supply leaf of the
Adapter DTM.

WHA-ADP1 # Dnline parameterization ] 4 b x
Device Name: WHA-ADP Device Revision: 1
Long Tag: WHA-ADP1 Descriptor: WIRELESSADAPTOR.
NE107 Status: . Good Timestamp of Status: 1411138
= Online parameterization
- Identification Power Mode: 1% __Automanc
Wireless Communication Field Device Table
Wired Cornmunication ManuFacturer 1D | Expanded Device T | Device ID Universal Comman | Long Tag Start-Up Voltage | Start-Up Time | Start-Lp Curre
- Device Yariable Mapping
= - Application Settings ABE TT%300 series 2087000 5 AEE_TTHIOO_M 16 5 14
= 420 mA
- Linearization
(= Burst Mode:
~Burst Mode 1 < I
~Burst Mode 2
~Burst Mode 3 -
Burst Mode 4 Apply fsld device power values
Burst Mode 5
~Burst Mode & Start-LUp Voltage: 16| ¥
~Burst Mode 7
~Burst Made & Start-Up Time! | 5 i s
Burst Mode 9 -
Burstinde: 10 Start-Lp Current: 14 ma
(= Event Motification
~ Ewent Notification 1 . ’ —
- Ewent Notification 2 SHE ety Lot 16 8
- Evenlt Notification 3
Event Notification 4 Lead Time: 10} s
Event Notification 5
- Power Supply Power-0n Time after External Trigger: H
Configuretion Time: | 300 5
Battery Changed:
Last Battery Change: £3 122,10.2009
Temperature Min: £ 14,4 | °C
Temperature Max; Eal 26,8| °C
Reeset Temp MinjMax:
Foometed | S 0 ooves [T
Figure 5.14 Power Supply parameters
ug
StartUp ___ |
Voltage 1
I
I
!
Operating ___ _ |
Voltage I | | | 1
i 1 1 1 1
h 1 1 1 ]
h 1 1 1 ]
| 1 1 1 1
h 1 1 1 ]
i 1 1 1 1
| 1 1 1 1
h 1 1 1 ]
i 1 1 1 1
| 1 1 1 1
h 1 1 1 ]
| 1 1 1 1
i | | | [
T T T T -
! StartUp | Lead | Command1i | Command2 | Penulimate | Last | Power-On |
1 Time | Time | ! ! Command ! Command | Time after |
i
i 1 1 External 1
1 i i i i i ' Tri !
1 I i 1 Ingger
i i i i
! I 1} ) U
- — -t L] Lot
1 device | 1 HART communication 1 1
| initializes i i i
' 1 1 1 1
to ty to tx toff
- HART synchronization additional
) configuration time
-
o
x . . . . .
N Figure 5.15 Parameters influencing the power requirement of the WirelessHART adapter
@©
(=2}
=
N
aV)
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Power Supply Parameters

Parameter

Description

Default

Power mode

Sets the power mode.
"Off": Power to any connected device is switched off.
There is no communication between adapter and any
connected device. Set this mode if the adapter is to be
used as a router.

"Automatic": The connected device is powered-up when
an external master starts communicating with the
adapter. The device is powered after the last command
for a period determined by "Power On Time After External
Trigger".

"Configuration": The connected device is powered-up
when the button on the adapter is pressed or an external
master communicates with it. The device is powered after
the last command for a period determined by
"Configuration Time". When this period has elapsed, the
power mode reverts to "Automatic”

Configuration

Field Device
Table

Displays the parameters read from the HART device by the
scan:

Manufacturer ID: Manufacturer of connected device

Expanded Device Type Code: Device identifier as per
HART

Device ID: Manufacturer’s device identifier

Universal Command Revision Level: HART revision
supported

Long Tag: Long tag of device (Message for HART revision
<6.0)

* Start-Up Voltage: Voltage required to start the
connected device

* Start-Up Time: Time required for the device to wake-up

* Start-Up Current: Current consumed on starting the
device

* Lead Time: Time that elapses between start-up and the
point when the HART communication is synchonized

* Parameters taken from DTM

Apply field
device power
values

Press this button to apply the field device power values.

Start-Up Voltage required by the connected device on start up. 16
Voltage Valid range 8 ... 23 V in steps of 0.1 V.
Filled automatically if the Field Device table is active.
Start-Up Time| Time in seconds required for the device to start up. 5
Filled automatically if the Field Device table is active.
Start-Up Current in mA drawn by the connected device during start- | 14
Current up.
Filled automatically if the Field Device table is active.
Operating Voltage connected device requires in normal operation. 16
Voltage Filled automatically if the Field Device table is active.
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Parameter Description Default
Lead Time Time that elapses between start-up and the point at which 10
the device can deliver valid values.
Filled automatically if the Field Device table is active.
Power-On Time that the connected device remains powered after the | 10
Time after last HART command. Applies to power mode "Automatic"
External only.
Trigger
Configuration| Time that the connected device remains powered after the | 300

Time

last HART command. Applies to power mode "Configuration”
only.

Battery
Changed

Press this button after a battery change to update the "Last
battery Change" display and reset the battery consumption
calculation.

Last Battery

Displays the date of the last battery change in DD:MM:YY.

Change

Temperature | Minimum temperature of the adapter since last temperature | —
Min. reset.

Temperature | Maximum temperature of the adapter since last temperature | —
Max. reset.

Reset Press this button to reset the Min/Max temperature monitor. | —
Max./Min.
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Operation

6 Operation
6.1 Controls and Indicators

The operating and display elements of the WirelessHART Adapter are located inside of the
housing. — see Figure 2.2 on page 11
They are used during the commissioning of the device and for local diagnosis.

()

(D)

(D)
L —— A

=

Ho

SHE
LA

Figure 6.1 Controls and indicators
1 Red LED

2 Green LED

3 Yellow LED

4 Button
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LEDs
Note!

To save battery power all LEDs are off during normal operation, even if the device is
communicating or joining the network. The LEDs only light up after start up or while pressing

the buttons.

When the pushbutton is pressed shortly (0.2 s ... 5 s), the three LEDs indicate the status of the
adapter. See chapter 6.1.2

LED Indicators

Number of LEDs

‘ 3 (green, yellow, red)

Indications of green LED (battery status)

LED on

Normal: at least one month of battery life is left.

LED flashes at 1 Hz

Warning: less than one month of battery life is left.

LED flashes at 3 Hz

Alarm: the battery is critically low, loop power cannot be supplied.
Any current signal cannot be read (4 ... 20 mA device).

The adapter still operates, but the connection is not assured.

LED off

Off: the battery is flat or disconnected.

Indications of yellow

LED (communication status)

LED on

Joined, alternative path: the device has full network connection. It is
able to communicate with at least 2 wireless nodes. At least one
alternative communication path to the gateway is available.

LED flashes at 1 Hz

Joined, no alternative path: the device was able to join the network.
However, it can communicate with a single wireless node only. There
is no alternative communication path to the gateway.

LED flashes at 3 Hz

Joining: the device is attempting to join the network. The adapter will
attempt to join for 40 minutes by default. Longer joining periods can be
configured if required.

LED off

Not joined: joining the network has failed. The device is no longer
attempting to join.

Indications of red LED (device status)

50 ms on Device in communication mode: it is possible to communicate with the
950 ms off adapter.
LED on Internal fault: device fault that cannot be remedied by the user.

LED flashes at 1 Hz

External fault: operative fault which can possibly be remedied by the
user:

Adapter temperature outside specified limits,
Measured value outside configured range.

Operative faults can be viewed with the Diagnosis function of the
DTM.

LED flashes at 3 Hz

Short-circuit: there is a short-circuit between terminals 1 and 2.

LED off

No fault

I3 PEPPERL+FUCHS
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Buttons

Depending on the duration that the button is pressed and on whether the battery is already
connected, the button calls different functions.

Duration

Function

Procedure

Pressing the button while the battery is already connected

<0.2s No function
0.2s..5s Status test Press button for more than 0.2 seconds and less than 5
seconds.
Release button.
The LEDs display the current device status. See chapter
6.1.1
5s...10s Join wireless Keep button pressed for 5 seconds.
twork
networ After 5 sesconds the yellow LED starts flashing at 3 Hz.
Release button.
The yellow LED extinguishes.
The adapter starts joining.
10s...15s Start _ Keep button pressed for 10 seconds. After 5 seconds the
configuration yellow LED starts flashing at 3 Hz. After 10 seconds the
mode red LED starts flashing at 3 Hz.
The adapter enters configuration mode.
Release button.
Configuration mode is retained until there was no HART
communication for 300 seconds (configurable) or until
pushbutton is pressed again for 10 seconds ... 15
seconds.
The red LED extinguishes.
>15s No function

Inserting the battery while the button is already pressed
The following functions are available when connecting the battery while the button is already
pressed. The duration starts from the moment the battery is connected (red LED lights).

<10s No function The red LED lights until the pushbutton is released.
10s...15s Configuration Keep button pressed for 10 seconds. The red LED lights
reset to default during this time.
settings
After 10 seconds the red LED starts flashing at 2.5 Hz.
Release button to start the reset.
20s...25s Firmware and Keep button pressed for 20 seconds. During this time the
configuration red LED lights for 10 seconds. Then the red LED starts
g%stt?:];%default flashing at 2.5 Hz. After this, the red LED lights again.
After 20 seconds the red LED starts flashing at 1.25 Hz.
Release button to start the reset.
>25s No function The red LED remains lit until the pushbutton is released
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6.2 Measured Value

The Measured Value function displays the current value and status of the variables selected in
the Device Variable Mapping dialog.

The following information is displayed:
= Primary Variable
m Secondary Variable
m  Tertiary Variable
» Quaternary Variable
= Loop-Current
) Accessing the Measured Value Window

1. Inthe PACTware™ project, right-click on the device.
Lo A context menu opens.
2. Select Measured Value.

L3 The Measured Value window appears.

WHA-ADP1 # Measured value | 4 b x
Device Name: WHA-ADP Device Revision: 1
Long Tag: WHa-abP1 Descriptor: WIRELESSADAPTOR
ME107 Status: . Good Timestamp of Status: 14:12:37
oEe
m Primary variable: 5 i
Secondary Yariable: 25 e
Tertiary Variable: 25 i
Quaternary Yariable: £3 .tl
Loop Current: 55 iy
-ﬁ;- Connected | gj__g_,__Device 1 ﬂ,\
Figure 6.2 Measured value

221980 2013-11

I3 PEPPERL+FUCHS 61



6.3

62

(e

Simulation

Adapter parameters can be simulated for test and commissioning purposes. When the
simulation is activated, the required parameter can be selected from a drop-down list. After a

value has been assigned,

the simulation is started by pressing Execute Simulation.

|E wha-aDP1 # Simulation |

Device Name:

Long Tag:
|

NE107 Status: [

=l

Simulation

WHA-ADP Device Revision: 1
WHa-ADP1 Descriptor: WIRELESSADAPTOR
Good Timestamp of Status: 14:13:00
Simulation; Enabled . v
Simulated Device Yariable: ;Loop Current V
Simulated Yalue: 13| mA
Execute Simulation: 3

% Connected & i Device

&

Figure 6.3 Simulation

Note!

The data listed in the following table is available only during online parameterization.

Simulation Parameters

Parameter

Description

Simulation

Enable or disable simulation mode.

Simulated Device
Variable

Select the device variable to be simulated.

Current Temperature

Temperature min: Minimum temperature of the adapter since last
temperature reset

Temperature max: Miaximum temperature of the adapter since last
temperature reset

Battery voltage

Consumed Energy

RSL of best neighbour (RSL = Received Signal Level)
RSL of second best neighbour

Battery voltage with load

Battery voltage without load during battery test
Normalized Consumed Energy

Estimated Lifetime

Loop Current

I3 PEPPERL+FUCHS
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Parameter Description

Simulated Value Enter simulated value.

Execute Simulation | Press this button to start simulation when simulation mode enabled.

Diagnostics

The Diagnostics function provides detailed information about the device, wireless/wired
communication and health status.

Note!

Available Only Online (DTM)

If using the configuration via DTM and PACTware™ the Diagnostics function is available only
online. see chapter 5.2

Accessing the Diagnostics Window

1. If using the DTM and PACTware™, right-click the device in the project tree and select Diag-
nostics.

2. If using the the web interface, select Diagnostics in the navigation area on the left.
Identification

Identification provides information about the hardware and software of the device.

| [ wha-aDP1 # Diagnostics | 4 b %
Device Name: WiHA-ADP Device Revision: 1
o Long Tag: ‘WHA-ADP1 Descriptor: WIRELESSADARTOR,
1
ME107 Status: ' Good Timestamp of Status: 14:14:09
| | @
= Di
i ] Long Tag: WHA-ADP1
‘Wireless Com.l.'ﬁunication
wired Communication Device Tag: WHA-ADP
= Health Status
MAaMUIR Descriptor: WIRELESSADSPTOR
ASM
HART Dake Code: 01.04.2009
Battery
Message: MNOME
Real Time Clock Time: £ |14:16:14,43750
Real Time Clock Date: 4% 27.01.2010
Device Revision: 1
Software Revision: 30
Hardware Revision: 1
Universal Command Revision: 7
== Connected &3 B Device =]
Figure 6.4 Diagnosis > Identification
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O Note!

H The data listed in the following table is available only during online parameterization.

Diagnosis - Identification

Parameter Description

Long Tag Identifies the device in a WirelessHART network.

Device Tag Identifies the field device within the process plant

Descriptor Further description of the device.

Date Code Date, dd.mm.yy, indicating the date of the last parameter change
Message User defined message.

Real time clock time

Shows the time currently set in the device.

Real time clock date

Shows the date currently set in the device.

Device Revision

Revision of the device.

Software Revision

Software revision of the device.

Hardware Revision

Hardware revision of the device.

Universal command

Revision of the HART protocol supported by the adapter.

revision
6.4.2 Wireless Communication
Wireless Communication provides information about the operation of the device within the
WirelessHART network.
'|F@ wHa-ADP1 # Diagnostics | q v
Device Mame: WHA-ADP Device Revision: 1 =
ol Long Tag: WHA-ADP1 Descriptor: WIRELESSADAPTOR.
NELOT Status: [l Goad Timestamp of Status:  14:14:09
[elEE
= Diag:f;imcamn Mebwark Identification: 1945
Wired Communication MAC:  |001bleSdetScE0ie
= Health Status
MAMUR Mickname: 3
ASM
HART Total Mumber of Meighbours: % 2
Batkery
‘wireless Health Status
Index Mickname | Mean RSL Packets Transmitte | Failed Transmits Packets Received
o 1 29 13 0 7
1 2 -16 a a il
% Connected ‘(’3 i Device @
Figure 6.5 Diagnosis > Wireless Communication
O Note!
H The data listed in the following table is available only during online parameterization.
64
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Diagnosis - Wireless Communication

Parameter Description

Network Network ID of the wireless network.

Identification

MAC MAC address of adapter

Nickname Short destination address of the device.

Total Number of Number of WirelessHART devices to which a connection has been
Neighbors established.

Wireles Health Key performance indicators of network communication:

Status Index: Identifier of neighbouring device

Nickname: Short destination address of neighbouring device

Mean RSL: Mean signal strength of neighbour since adapter
joined the network

Packets Transmitted: Number of packets sent by adapter since
joining the network

Failed Transmits: Number of packets sent by adapter since joining
the network and that failed to reach their destination (after retries)

Packets Received: Number of packets received by adapter since
joining the network
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6.4.3 Wired Communication
Wired Communicatioin provides information about the HART device(s) connected to the
adapter.
WHA-ADP1 # Diay ics | 4rx
Device Name: WHA-ADP Device Revision: 1
Long Tag: WHA-ADP1 Descriptor: WIRELESSADAPTOR
NE107 Status: [l Good Timestamp of Status: 14:15:26
oHe
1=l Di i .
S ication ‘Wired Communication Status
o Index | Long Tag | ST Count ACK Count; BACK Count
" Battery 1 AEE_TTHIOON 222 222 0
Tconnected | (& B vevee .
Figure 6.6 Diagnosis > Wired Communication

Diagnosis - Wired Communication

Parameter Description
Number of Devices | Number of HART devices connected to the adapter.
Wired Key performance indicators of network communication:
ggt\:::unication = Index: Identifier of HART device
m Long Tag: Long tag of connected device
m STX Count: Number of transactions started by the adapter
= ACK Count: Number of HART device acknowledgements to

adapter
m BACK Count: Number of HART device burst messages

221980 2013-11
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6.4.4 Health Status

The Health Status menu contains diagnostic information. The information is displayed in three
different ways according to:

= NAMUR NE107 guidelines,
= ASM guidelines,
m HART specification.

Open the corresponding sub-menu to view the respective information.

[ wHa-aDP1 # Diagnostics | 4px
Device Name: WHA-ADP Device Revision: 1
Long Tag: WHA-ADP1 Descriptor: WIRELESSADAPTOR
MNE1D7 Status: . Good Timestamp of Status: 14:15:26
= Diagnosis

-~ Identification
- Wireless Communication

_ . 3 M ' [
== connected | !ﬁtﬁé\vi@g [ i% Iz
Figure 6.7 Diagnosis > Health Status > NAMUR

The following status messages according to the NAMUR NE107 guidelines can be displayed:
= Good

Failure (F)

Maintenance (M)

Out of specification (S)

Function check (C)

221980 2013-11
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[ wha-aDP1 # Diagnostics | 4bx
Device Name: WHA-ADP Device Revision: 1
Long Tag: WHA-ADP1 Descriptor: WIRELESSADAPTOR
NE107 Status: . Good Timestamp of Status: 14:16:02
= Diagnosis

- Identification

Wireless Communication
Wired Communication
Health Status

2
= connected ]gﬁ Device = iﬁ

Figure 6.8 Diagnosis > Health Status > ASM

The following status messages according to the ASM guidelines can be displayed:
Good, device operating as normal

Faults in the sensor or actuator element

Faults in the electronics

Installation faults, fault during start-up

Faults due to process influence, faults due to non-compliance with specified operating
conditions.

221980 2013-11
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HART

|| wHa-ADP1 # Diagnostics qbx
Device Name: WHA-ADP Device Revision: 1
= Long Tag: WHA-ADPL Descriptor: WIRELESSADAPTOR
1
NE107 Status: [l] Good Timestamp of Status: 14:16:02
2 Diagnosis ) ) s [
Idertification Configuration Change Counter: £ 51 —
Wireless Communication
wWired Communication Configuration Changed Flag:
= Health Status
HAMUR, Rebaot Counter: §% 05
A _
HART | Device-Specific Status 0: §% [ Ma join attempt started so far,
Battery [ adapter is nok connected to a wireless netwatk,
[ adapter has either no connection o only ane neighbor.
O Currently there is set no join key.
[ adapter was not able to join the wireless network.
Device-5pecific Status 1: {5 [ Adapter was not able to communicate to the field device,
[ Adapter was not able to power the field device.
[ & shert circuit was detected on the wired interface,
[ It was not possible ko provide the starkbup volkage.
[ It was nok possible ko pravide the operation voltage.
[ The Adapter is in configuration mode.
[ The Adapter searches for connected devices,
[ The &dapter Found maore than 4 field devices,
Device-Specific Status 2: 1% [ Hardware is defert.
[ The Adapter executes a self test,
[ Temperature of Adapter is not within its specified range.
[ Hardwars is defect,
[ Mumber of write cydes ta FLASH reached critical level,
[ Number of write cycles of the FLASH reached mazximurn level,
[ Hardware is defect.
Device-Specific Status 3: % Loop current reached the configured lawer warning level, 1
e I il sy PO M ann fovvack vaschad ha confionrad Dnnee wavaine lewal )
% Connected 5] g Device ﬁ
Figure 6.9 Diagnosis > Health Status > HART

Diagnosis - Health Status - HART

Parameter

Description

Configuration Change Counter

Counter which increments by one on every change in
adapter configuration.

Configuration Changed Flag

Indicates a change in configuration since the last call up.

Reboot Counter

Counter which increments by one on every reboot of the
adapter.

Device Specific Status 0

Indicates network status.

Device Specific Status 1

Indicates wired communication status.

Device Specific Status 2

Indicates internal wireless communcation module status.

Device Specific Status 3

Indicates status of current signal of the connected device.

Device Specific Status 4

Indicates a device malfunction.

Extended Device Status

Indicates the general status of the device.

Standardized Status O

Indicates the status of the adapter.

Analog Channel Saturated

Indicates that current signal of the connected device is
overrange.

Standardized Status 2

Indicates the standardized status of the wired (HART)
connection.

Standardized Status 3

Indicates the standardized status of the network.

Real Time Clock

Current time.
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6.4.5 Power Supply

The Diagnosis > Power Supply > Battery menu contains information on the battery unit of

the device.
||l wHa-ADP1 # Diagnostics q4bx
Device Name: WHA-ADP Device Revision: 1
= Long Tag: WwHA-ADP1 Descriptor: WIRELESSADAPTOR.
\
MNE107 Status: . Good Timestamp of Status: 14:16:39
——
bR e
{= Diagnosis At e -
Identification Ml ol
‘Wireless Communication .
wiired Communication Battery Yoltage: 43 N7
(= Health Status
MAMUR Consumed Energy: 4% | 0,05035111 | &h
ASM
HART Normalized Consurned Energy: 1}
Battery
Temperature: L3 222 e
Temperature Min: 1;5: 14,4 | °C
Temperature Max: 13 26,8 | °C
% Connecked s i Device @
Figure 6.10 Diagnosis > Battery

Diagnosis - Battery

Parameter Description

Estimated lifetime | Number of days battery power will last under the current load
conditions.

Battery Voltage Current voltage of the battery

Consumed Energy | Current consumed energy

Normalized Consumed energy with respect to normalized conditions

Consumed Energy

Temperature Current temperature of device.

Temperature Min Minimum temperature of the adapter since last temperature reset

Temperature Max Maximum temperature of the adapter since last temperature reset

70 FPEPPERL+FUCHS
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6.5 Additional Functions
) Accessing the Additional Functions window

1. Ifusingthe DTM and PACTware ™, right-click the device in the project tree, select Addition-
al functions and choose the desired functuion.

2. If using the the web interface, select Additional Functions in the navigation area on the
left.

6.5.1 Lock / Unlock

You can protect the device against unauthorized or undeliberate parameter changes (write
protection).

|| El wra-aDP1 # Lock / Unlacke | 4bx
Device Name: WHA-ADP Device Revision: L
i Long Tag: WHA-ADPL Descriptor: WIRELESSADAPTOR
|
NE107 Status: [ Giood Timestamp of Status: 14117311
ll=I07
ockinleck LockCode: | Unlocked ]
Lock Status: 4% [ Device Locked
[ Lack is Permanent:
[ Locked by Primary Master (Reset if Secondary Master)
[ Canfiguration Cannat B= Changed
[ Lacked by Gateway
Wireless Module Firmware Update Lock: | Locked Tsel
b connected 12 B pevice =1
Figure 6.11 Additional functions > Lock / Unlock

Lock / Unlock
Parameter Description

Lock Code Unlocked: Adapter is unlocked, all parameters can be changed

Lock Temporary: Adapter is locked. A device reset or power loss
will unlock it

Lock Permanent: Adapter is locked. It can be unlocked by a master
only

Lock All: Adapter is locked. It can be unlocked only by the master
that locked it

Lock Status Device Locked

Lock is Permanent

Locked by Primary Master (Reset if Secondary master)
Configuration Cannot be Changed

Locked by Gateway

Wireless Module Unlocked: Adapter firmware can be downloaded
Fi dat
Lg‘g?(ware Update Locked: Adapter firmware cannot be downloaded

I3 PEPPERL+FUCHS 7
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6.5.2 Update Firmware

Update firmware is used to download new adapter firmware locally or from an FTP server to
the adapter. The parameter Wireless Module Firmware Update Lock in Lock/Unlock must
be set to "Unlock" before the firmware can be downloaded.

| wHa-ADP1 # Update firmware | abx
Device Name: WHA-ADF Device Revision: 1
Long Tag: WHA-ADP 1 Descriptor: WIRELESSADAPTOR.
NE107 Status: . Good Timestamp of Status: 14:17:42
@

Update firmware

Firmiware Update File FTP-URL:
FIP Lser:

FTP Password:

Update Firmware:
FIVmWH!’E"VeEﬂD.n:

< connectad \E]j_mama B Jg

Figure 6.12 Additional functions > Update firmware

Update Firmware

Parameter Description

Firmware Update URL of the FTP server or path and file name of a local storage
File FTP-URL medium.

FTP User User name for FTP server.

FTP Password User password for FTP server.

Update Firmware Press this button to start firmware update procedure.
Firmware Version Current firmware version of the adapter.

221980 2013-11
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6.5.3 Device DTM Info

Device DTM Info gives standardized information about the adapter to which the DTM is

connected.

WHA-ADP1 # Device DTM Info l 4 b X
Device Name: WHA-ADP Device Revision: 1

Long Tag: WHA-ADP1 Descriptor: WIRELESSADARPTOR
NE107 Status: [ Timestamp of Status: 141742
o[me
Device DTM Info Deona o

Firmpsare Yersion: 01,01,00-1423

0% comnected 2 B pevice [ e

Figure 6.13 Additional Functions > Device DTM Info

Device DTM Info
Parameter Description

Device Tag Normally identifies the measuring point in the plant
Firmware Version Current firmware version of the adapter

6.5.4 Self Test

After pressing the Perform Self-Test button in the Additional Functions > Self Test menu the
device carries out a self test.

The results of the self test can be seen in the Diagnostics menu. see chapter 6.4
6.5.5 About

Additional Functions > About displays information about the device, its manufacturer, and its
firmware version.

221980 2013-11
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Maintenance and Repair

Exchanging the Battery

New battery units for the adapter of the type W-BAT-B2-Li can be ordered from Pepperl+Fuchs
under the part no. 220390.

Note!

= When operating at ambient conditions different from the conditions specified, battery
capacity can be reduced up to 50%.

m  The device has internal battery diagnostics that can send a warning when battery
conditions are outside the acceptable operating range.

Changing the Battery

1. Open the adapter housing by unscrewing the four Phillips screws.
2. Pull the battery connecting cable plug from its socket.

3. Press the two clips which secure the battery simultaneously to the middle and remove the
old battery unit.

4. Press the new battery unit into position.

L The pack is properly secured after the two clips have made an audible click.
5. Insert the battery connecting cable plug into the socket in the printed circuit board.
6. Close the housing cover and screw it tight.

7. Reset the measurement of the consumed battery charge by pressing the Battery Changed
button in the device DTM. see chapter 5.8

L The measurement is reset.
Disposal of Batteries

The battery / the battery unit is non-rechargeable. The batteries are non-hazardous when used
according to the recommendations of the manufacturer. However, they do contain hazardous
substances and therefore must be disposed of in compliance with the applicable laws and
guidelines of the corresponding country.

221980 2013-11

I3 PEPPERL+FUCHS



221980 2013-11

8 Troubleshooting
8.1 Faults Indicated by LEDs

Note!

To save battery power all LEDs are off during normal operation, even if the device is
communicating or joining the network. The LEDs only light up after start up or while pressing
the buttons.

(10

For more information on the LED indications, see chapter 6.1.1.

Green LED (battery status)

State

Possible Cause(s)

Action(s)

LED flashes at 1 Hz

Warning: less than one month
of battery life is left.

Change battery as soon as
possible. See chapter 7.1

LED flashes at 3 Hz

Alarm: the battery is critically
low, loop power cannot be
supplied.

Change battery immediately.
See chapter 7.1

LED off

Off: the battery is flat or
disconnected.

Change/connect battery. See
chapter 7.1

Yellow LED (communication status)

State

Possible Cause(s)

Action(s)

LED flashes at 1 Hz

Joined, no alternative path:
the device was able to join the
network. However, it can
communicate with a single
wireless node only. There is
no alternative communication

Add a WirelessHART
device that is within the
antenna range of the
adapter.

Change the position of the
path to the gateway. adapter
LED flashes at 3 Hz Joining: the device is none

attempting to join the network.

LED off

Not joined: joining the network

has failed.The device is no

longer attempting to join.
There are no
communication paths
available.

No WirelessHART network
has been set up so far.

The Network ID and/or
Join Key is not correct.

Add a WirelessHART
device that is within the
antenna range of the
adapter and try joining the
network again.

Change the position of the
adapter and try joining the
network again.

Install a WirelessHART
gateway first. Set up a
WirelessHART network.

Check Network ID and
Join Key.
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Red LED (device status)

State

Possible Cause(s)

Action(s)

LED on

Internal Fault: an internal fault
condition has been identified

Send the device back to the
manufacturer.

LED flashes at 1 Hz

External Fault: operative fault
that can possibly be remedied
by the user (e.g. adapter
temperature outside specified
limits, measured value outside
configured range).

Check the Diagnosis function
of the DTM to find out what
kind of error has occurred.
See chapter 6.4

LED flashes at 3 Hz

Short-circuit: there is a short-

Check wiring. See chapter 3.3

and 2.

circuit between terminals 1

Wireless Communication Faults

communicating
via
WirelessHART
Gateway.

Fault Possible Cause(s) Corrective Action(s)

PACTware™ The device has not yet joined the The joining process may take a
cannot find the | network. while. Check the join status in the
device when gateway's Instrument List.

Alternatively, check the wireless
communication parameters (join
status) of the device via a HART
modem connected to the device. If
the device does not join, check the
next fault.

The device carries the wrong
Network ID and/or Join Key.

Check the wireless communication
parameters of the device viaa HART
modem connected to the device.
The device and the gateway must
have the same Network ID and Join
Key.
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Fault

Possible Cause(s)

Corrective Action(s)

The device does
not join the
network.

No battery or low battery

Check that a fresh battery of the
correct type is inserted.

The device carries the wrong
Network ID and/or Join Key.

Check the wireless communication
parameters of the device via a HART
modem connected to the device.
The device and the gateway must
have the same Network ID and Join
Key.

No neighboring WirelessHART
devices are within the device's
antenna range.

Check the number of neighbors
in the device DTM (wireless
communication parameters).
There should be at least 2
neighbors.

If there are no reachable
neighbors, check the device's
mounting position: Are there any
obstacles? If yes, change the
mounting position.

If there are no reachable
neighbors and you can not
change the device's mounting
position: Try moving an other
WirelessHART device in the
network, or adding a new one.

Device not mounted correctly

Check that the device has been
mounted correctly. See chapter 3.1

Device not trying to join

Check whether the device is trying to
join the network (LEDs): if not, start a
new connection attempt by pressing
the correct button. See chapter 6

Device
disappears
sporadically from
the network

There are not enough neighboring
WirelessHART devices within the
antenna range of the device.

Check the number of neighbors in
the device DTM (wireless
communication parameters). There
should be at least 2 neighbors.
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8.3 Wired Communication Faults
Fault Possible Cause(s) Corrective Action(s)
PACTware™ HART communication DTM not Select the correct COM port from the
cannot find the | connected to correct COM port drop-down menu.
adapter when RS-232C = COM1 or COM2
gommineating USB = COMx as displayed
modem. Check to which COM port your
HART modem is connected. See
chapter 4.3
Then set the correct COM port in the
HART communication DTM. See
chapter 4.5.2
HART modem plugged into wrong Plug the HART modem into the
USB port (some computers assign correct USB port.
fixed COM ports to USB ports). . _
Maybe you are using a different USB Alternatively, adjust the COM
port than during setup. port setting in the HART
communication DTM. See
chapter 4.5.2
Adapter address not found by the Configure the correct address
HART communication DTM range. See chapter 4.5.2
Default adapter address = 15
For USB/HART modems, voltage Switch in the communication resistor
level at Terminals 7 and 8 to high for | or connect a 250 Q resistor across
reliable communication terminals 5/7 and 6/8. See chapter
3.3.1
A field device Battery not connected or exhausted Check the connection, if
powered by the necessary replace the battery.
adapter will not ) )
start up A simple check is to shake the
adapter or battery unit. If you
hear liquid, the battery still has
life.
Power supply parameters are Find the correct parameters in the
incorrect device manual and enter them into
the DTM. See chapter 5.8
Connected field device has a very | Connect a resistor in series with the
low impendance - the adapter device, for example, a 250 Q
interprets this as a short-circuit and | resistor.
switches off the power
The parameters | Device does not support HART Parameters can be read from a
of a field device | protocol HART device only.
powered by the Device address not found by the Check the highest scan address.
adapter cannot Adapter DTM S haoter 5.5
be read by the apter ee chapter 5.
\a/&ilapéer DTM. Device not powered See previous fault.
Cc|>rr(ra1munication Device powered, but shuts down Increase power supply parameter
Dialog: see before it communicates ‘Lead Time" in steps of 10 s until the
chapter 5.5 fault is eliminated. See chapter 5.8
78
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Fault

Possible Cause(s)

Corrective Action(s)

The parameters
of an
independently
operating 4-wire
field device
cannot be read
by the adapter
DTM.

Wired
Communication
Dialog: see
chapter 5.5

Device does not support HART
protocol

Parameters can be read from a
HART device only.

Device address not found by the
Adapter DTM

Check the highest scan address.
See chapter 5.5

Device not powered

Check the power supply of the
device.

Device not wired up correctly

Check the wiring. See chapter 3.3.1

The parameters
of afield device in
a control loop
cannot be read

Device does not support HART
protocol

Parameters can be read from a
HART device only.

Device address not found by the
Adapter DTM

Check the highest scan address.
See chapter 5.5

by the adapter
\?VTMd Device not powered Check loop power.
ire

Communication | Device not wired up correctly Check the wiring of the device. See

Dialog: see chapter 3.3.1

chapter 5.5 PLC or Remote I/O acting as primary| Configure adapter as secondary
master forces adapter to operate as | master. See chapter 5.5
slave

PACTware™ For control loops with Configure the correct address range.

cannot find a field| communication resistor: See chapter 4.5.2

device connected| Device address not found by the

toTerminals 1 + 2
or 2 + 3 of the
adapter when
communicating
through a HART
modem
connected to
Terminals 5/7 and
6/8

HART communication DTM

For control loops without
communication resistor, for 2-wire
devices powered by adapter and for
4 wire devices:

No communication path to device
(design feature)

Depending upon circuit, connect
modem across terminals 1 and 2
or 2 and 3. See chapter 3.3.1

Configure the correct address
range. See chapter 4.5.2

For all connections:
Device not powered

Check the power supply of the
device.

Adapter does not
restart after
disconnecting
and connecting
the battery

Battery reconnected before adapter
power fully discharged

1. Disconnect the battery again.
2. Press button for 3 seconds.
3. Wait one minute.

4. Reconnect the battery.

PACTware™
cannot find a
connected HART
device when
communicating
via
WirelessHART
Gateway.

Device does not support HART
protocol

Parameters can be read from a
HART device only.

Device address not found by the
Adapter DTM

Check the highest scan address.
See chapter 5.5

Device not powered

See second fault.

Device powered, but shuts down
before it communicates

Increase power supply parameter
"Lead Time" in steps of 10 s until the
fault is eliminated. See chapter 5.8
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Technical Specifications
WHA-ADP-F8B2-*-GP(-1)

Supply

Rated voltage

‘ 7.2V DC, battery operated

Electrical specifications

Output rated operating current

4..20mA

Supply

loop power for field devices
voltage 8 ... 23 V DC, adjustable in steps of 0.1 V

Input

Number of channels

Connectable field devices

usable for:

- one point-to-point connection with a HART field device, or

- one point-to-point connection with a 4 ... 20 mA field device,
or

- up to four externally powered HART field devices operating in
multidrop mode

Connection terminals 1, 2, 3, 4,5, 6
multiple wirings available , depending on operating mode
Current 4...20mA

HART communication

Protocol

HART 7.1, backward compatible

Number of devices

- one passive 4 ... 20 mA/HART field device
- up to 4 HART field devices in multidrop mode

Transfer rate

1200 Bit/s

Parameters primary/secondary master, preambles, retries and short
address scan ranges
Output
Interface omnidirectional dipole antenna, adjustable in vertical plane

Output variables

PV: loop current

SV, TV, QV:configurable according to user requirement

- adapter: temperature, battery voltage, energy consumed and
estimated battery life-time

-4 ... 20 mA device: scaled or linearized process value

- HART device: up to four process variables

Communication

WirelessHART specifications

- physical layer: IEEE 802.15.4.2006

- frequency band: 2.4 GHz (ISM band, licence free)

- transmission rate: 250 kBit/s

- max. transmit power: +10 dBm (EIRP)

- transmission range: outdoor 250 m, indoor 50 m (under
reference conditions)

- communication standard: WirelessHART

Transfer characteristics

Accuracy

current input: 0.125 % of measuring range

Influence of ambient
temperature

current input: 5 pA/K

Indicators/settings

Display elements

green LED: battry status
yellow LED: communication status
red LED: device status

I3 PEPPERL+FUCHS
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Controls

1 push botton for:

- device status

- enter/leave configuration mode
- join trigger

- factory reset

Configuration

wired interface:

- HART 7.1, FSK compatible

- transmission rate: 1200 Bit/s

- used for device commissioning with an handheld terminal or
a configuration tool (DTM)

Parameter assignment

- wireless transmit power: configurable to 0 dBm or 10 dBm
(EIRP)

- device variables mapping

- publishing of up to ten burst messages in a wireless network,
period and trigger mode selectable

- notification of up to five events from adapter and/or
connected device(s) in a wireless network

- scaling and linearization of 4 ... 20 mA signal of connected
analog device

- tuning of supply parameters for the connected device

- locking/unlocking of device parameterization

Directive conformity

Electromagnetic compatibility

Directive 2004/108/EC

EN 61326-1:2006

Radio and telecommunication
terminal equipment

Directive 99/5/EC

ETSI EN 300328: V1.7.1 (2006-10), ETSI EN 301489-17:
V1.2.1 (2002-08), EN 60950:2001

FCC CFR47 Part15Band C

ANSI C63.4-2003

Conformity

Protection degree

IEC 60529

Shock resistance

EN 60068-2-27

Vibration resistance

EN 60068-2-64

Ambient conditions

Ambient temperature

-40...80 °C (-40 ... 176 °F)

Storage temperature

-40 ...85°C (-40 ... 185 °F)

Relative humidity

max. 90 % , noncondensing

Vibration resistance

20 ... 2000 Hz, 0,01 g?/Hz

Impact resistance

159,11 ms

Corrosion resistance

acc. to ISA-S71.04-1985, severity level G3
test setup and execution acc. to EN 60068-2-60

Mechanical specifications

Housing width 110.4 mm

Housing height 192 mm

Housing depth 100.6 mm

Protection degree IP66

Cable entry M20 x 1.5 ; enclosed cable gland

Material plastic

Mass approx. 750 g

Dimensions 91 x 88.5 x 100.6 mm (3.6 x 3.5 x 4 in) (without cable glands

and antenna)
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Mounting mounting on field device , panel or pole mounting
versions see type code

General information

Supplementary information EC-Type Examination Certificate, Statement of Conformity,
Declaration of Conformity, Attestation of Conformity and
instructions have to be observed where applicable. For
information see www.pepperl-fuchs.com.

Accessories

Designation battery W-BAT-B2-Li mandatory for use in connection with
hazardous areas (order separately)
mounting set W-ACC-MKF8

9.2 Dimensions
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9.3 Telecommunication Compliance
ETSI (R&TTE)

FCC Part 15.247 for wireless applications in the area of 2.4 GHz

EN 300 328

The usage of 2400 MHz equipment is bound to local restrictions. Ensure that local restrictions
allow usage of this product before commissioning.

Country

Guideline

Bulgaria

General authorization required for outdoor use
and public service.

ltaly

If used outside of own premises, general
authorization is required.

Japan

The device is granted pursuant to the
Japanese Radio Law and the Japanese
Telecommunications Business Law.

The device must not be modified (otherwise
the granted designation number will become
invalid).

Latvia

The outdoor usage of the 2.4 GHz band
requires an authorization from the Electronic
Communications Office.

Norway

May be restricted in the geographical area
within a radius of 20 km from the center of Ny-
Alesund.

Rumania

Use on a secondary basis. Individual license
required.
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